EFI Fiery Color Printing
Technical Reference
# CONTENTS

## INTRODUCTION
- Terminology and conventions ........................................ 7
- About this document .................................................... 8
- Key features of ColorWise .............................................. 8

## COLORWISE PRO TOOLS
- About this chapter .......................................................... 10
- Setting up ColorWise Pro Tools on a Windows computer .......... 11
  - Installing ColorWise Pro Tools ...................................... 11
  - Installing the ICC profiles .......................................... 11
  - Configuring the connection ........................................ 13
  - Editing the configuration .......................................... 14
- Setting up ColorWise Pro Tools on a Mac OS computer .......... 16
  - Installing ColorWise Pro Tools on a Mac OS computer ....... 16
  - Installing the ColorSync profiles .................................. 16
  - Configuring the connection ........................................ 17
  - Editing the configuration .......................................... 19
- Using ColorWise Pro Tools ............................................. 20
  - Using Calibrator ....................................................... 20
  - Using Color Editor .................................................... 20
  - Using Profile Manager ............................................... 25
  - Using Spot-On .......................................................... 30
  - Using Color Setup .................................................... 30

## CALIBRATION
- About this chapter .......................................................... 33
Calibrating with ColorWise Pro Tools Calibrator

- Starting Calibrator
- Expert mode
- Applying measurements to multiple calibration sets
- Restoring default calibration measurements
- Calibrating with ColorCal
- Calibrating with the DTP32 or DTP32 Series II
- Calibrating with the DTP41
- Calibrating with the ED-100
- Calibrating with the ES-1000

Calibrating from the copier/printer touch panel

- Calibrating with ColorCal
- Calibrating with VisualCal

Understanding calibration

- An overview of calibration
- How calibration works
- Scheduling calibration
- Checking calibration status

SPOT-ON

Using Spot-On

- Starting Spot-On
- Spot-On main window
- Working with existing colors
- Creating custom colors
- Downloading custom color groups
- Uploading custom color groups
- Editing color values
- Using a measurement instrument to target colors
- Reverting default colors to factory settings
- Saving changes and exiting Spot-On
## Spot-On with Substitute Colors

- Creating a color for substitution
- Defining the color values for a substitute color
- Printing a job with a substitute color
- Substitute Color dialog box
- Principles for Substitute Colors
- Uploading and downloading a substitute color group

## COLORWISE PRINT OPTIONS

### About this chapter

Managing color on the CX3641MFP

<table>
<thead>
<tr>
<th>ColorWise print options</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Trapping</td>
<td>84</td>
</tr>
<tr>
<td>Black Detection</td>
<td>84</td>
</tr>
<tr>
<td>Black Overprint</td>
<td>85</td>
</tr>
<tr>
<td>Black Text/Graphics</td>
<td>86</td>
</tr>
<tr>
<td>CMYK Simulation Profile</td>
<td>87</td>
</tr>
<tr>
<td>CMYK Simulation Method</td>
<td>88</td>
</tr>
<tr>
<td>Combine Separations</td>
<td>89</td>
</tr>
<tr>
<td>Composite Overprint</td>
<td>90</td>
</tr>
<tr>
<td>Output Profile</td>
<td>91</td>
</tr>
<tr>
<td>Print Gray using Black Only</td>
<td>91</td>
</tr>
<tr>
<td>Rendering Styles</td>
<td>92</td>
</tr>
<tr>
<td>RGB Separation</td>
<td>92</td>
</tr>
<tr>
<td>RGB Source Profile</td>
<td>93</td>
</tr>
<tr>
<td>Spot Color Matching</td>
<td>94</td>
</tr>
<tr>
<td>Substitute Colors</td>
<td>95</td>
</tr>
</tbody>
</table>

### Printer drivers and print options

- Setting print options for Windows
- Setting color management print options for Mac OS
- Using Expert Color Settings to enable Device Link Profiles
**CONTENTS**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IMPORTING DENSITY MEASUREMENTS</strong></td>
<td>101</td>
</tr>
<tr>
<td>Simple ASCII Import File Format</td>
<td>101</td>
</tr>
<tr>
<td>Example of 1D Status T density for EFI 21 patch page</td>
<td>102</td>
</tr>
<tr>
<td>Example of 1D Status T density for EFI 34 patch page</td>
<td>102</td>
</tr>
<tr>
<td>Example of 1D Status T density for an arbitrary page</td>
<td>103</td>
</tr>
</tbody>
</table>

**INDEX**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX</td>
<td>104</td>
</tr>
</tbody>
</table>
INTRODUCTION

This document explains how to manage color output on the CX3641MFP and provides information about calibration and color profiles.

This document is part of a set of documentation that includes documentation for users and system administrators. For a complete description of your CX3641MFP, see the other documentation available at your site.

Terminology and conventions

This document uses the following terminology and conventions.

<table>
<thead>
<tr>
<th>Term or convention</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command WorkStation</td>
<td>Command WorkStation, Windows Edition and Command WorkStation, Macintosh Edition</td>
</tr>
<tr>
<td>Mac OS</td>
<td>Apple Mac OS X</td>
</tr>
<tr>
<td>Titles in <em>italics</em></td>
<td>Other documents in this set</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td>Topics for which additional information is available by starting Help in the software</td>
</tr>
<tr>
<td><img src="image" alt="Tip" /></td>
<td>Tips and information</td>
</tr>
<tr>
<td><img src="image" alt="Important" /></td>
<td>Important information</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>Important information about issues that can result in physical harm to you or others</td>
</tr>
</tbody>
</table>
About this document

This document is organized to supply you with key information about managing the color output of your CX3641MFP.

This document covers the following topics:

• Installing and configuring ColorWise Pro Tools
• Using Color Editor, Profile Manager, and Color Setup
• Overview of calibration and description of how to calibrate the CX3641MFP using various ColorWise Pro Tools Calibrator methods
• Using Spot-On to manage spot colors
• Setting ColorWise print options from Windows and Mac OS computers
• Descriptions of Simple ASCII File Format (SAIFF), which can be used to import toner density measurements from measurement devices

**NOTE:** The *Glossary* defines words in bold, for example, **output profile**, that appear throughout this document. Color terms and concepts, such as “color space,” “spot color,” “gamut,” and “source profile,” are used throughout this document. If you are new to desktop color, or if any terms are unfamiliar, see the *Glossary*.

Key features of ColorWise

**ColorWise** is the **color management system (CMS)** built into the CX3641MFP and designed to provide both casual and expert users with the best color output for a variety of purposes. The ColorWise default settings provide high-quality, out-of-box color from many Windows and Mac OS applications. This allows casual users to achieve quality output without knowing about or changing any color settings on the CX3641MFP.

For consistent color, calibrate the CX3641MFP on a regular basis. ColorWise Pro Tools includes an easy-to-use calibrator, which allows you to calibrate using either the scanning unit that is part of the copier/printer or an optional **spectrophotometer** or **densitometer** (see “Calibration” on page 33).

ColorWise features allow you to modify printing results. Depending on your particular needs, you can:

• Set the behavior of **CMYK** printing to emulate **DIC, Eurosclae, SWOP**, and other offset press standards.

• Match PANTONE and other **spot colors** for the best match when printing using four-color press conditions or presses with extra, custom plates.
• Select a color rendering dictionary (CRD), also called a rendering style, for RGB printing. CRDs allow for rich, saturated printing of presentation graphics, smooth, accurate printing of photographs, and relative or absolute colorimetric rendering for specialized needs.

• Define the source of incoming RGB color data for better color conversion of RGB data with no source information.

• Determine whether RGB data is converted into the full gamut of the copier/printer or is first converted into the gamut of another device, such as a press standard. This feature is useful for making one device behave like another for RGB data. It also allows you to evaluate the appearance of an RGB file under different printing conditions without having to convert the RGB file to CMYK first.

ColorWise color management (ColorWise) offers an open color architecture, allowing users to customize the CX3641MFP to meet new printing needs as they arise. ColorWise supports ICC profiles, which are industry standard color profiles that describe the color behavior of a device. Note that ICC specification version 4 profiles (profile version 4.2.0.0) are supported as well as version 2. Downloading ICC profiles to the CX3641MFP enables the CX3641MFP to simulate a custom press (or another copier/printer), as well as accurately print colors from a particular monitor or scanner. In addition, you can create customized ICC profiles for the copier/printer.

ColorWise also allows you to use any Status T densitometer by importing data in a standard file format (see “Importing Density Measurements” on page 101). In this case, it is important to note that the quality of the instrument used determines the quality of the calibration.
COLORWISE PRO TOOLS

The ColorWise default settings provide high-quality out-of-box color from many Windows and Mac OS applications. This allows casual users to achieve quality output without knowing about or changing color settings on the CX3641MFP. The ColorWise color management system (CMS) also allows expert users to obtain the best color output. ColorWise Pro Tools allows users to customize settings to achieve the best output for a variety of purposes.

Designed to give flexible control of color printing, ColorWise Pro Tools includes the following color management tools:

- Calibrator (calibrate the CX3641MFP in various ways)
- Color Editor (customize simulation and output profiles)
- Profile Manager (manage profiles)
- Spot-On (define CMYK equivalents for spot colors)
  
  Spot-On is offered as an option.
- Color Setup (set defaults for ColorWise print options)

About this chapter

This chapter describes the procedures for installing, configuring, and using ColorWise Pro Tools on Windows and Mac OS computers.

<table>
<thead>
<tr>
<th>Platform</th>
<th>To do this</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Install ColorWise Pro Tools</td>
<td>page 11</td>
</tr>
<tr>
<td></td>
<td>Install the ICC profiles</td>
<td>page 11</td>
</tr>
<tr>
<td></td>
<td>Configure the connection</td>
<td>page 13</td>
</tr>
<tr>
<td></td>
<td>Modify the configuration</td>
<td>page 14</td>
</tr>
<tr>
<td>Mac OS</td>
<td>Install ColorWise Pro Tools</td>
<td>page 16</td>
</tr>
<tr>
<td></td>
<td>Install the ColorSync profiles</td>
<td>page 16</td>
</tr>
<tr>
<td></td>
<td>Configure the connection</td>
<td>page 17</td>
</tr>
<tr>
<td></td>
<td>Modify the configuration</td>
<td>page 19</td>
</tr>
</tbody>
</table>
Setting up ColorWise Pro Tools on a Windows computer

The following sections describe how to install ColorWise Pro Tools and other files and configure the connection on a Windows computer.

Installing ColorWise Pro Tools

To use ColorWise Pro Tools on a Windows computer, you must install Sun Java 5. If this file is not installed on your computer, the ColorWise Pro Tools installer automatically initiates the installation process.

TO INSTALL COLORWISE PRO TOOLS ON A WINDOWS COMPUTER

1. Open the ColorWise Pro Tools folder on the User Software (Utilities) CD.
2. Double-click the Setup.exe icon.
3. Follow the on-screen instructions to complete installation.

Installing the ICC profiles

You can copy additional ICC profiles from the User Software (Drivers) CD to your computer. Use the ICC profiles with applications that support ICC standards, such as Adobe Photoshop. For most ICC-aware applications, you must install the files in a folder named Color. For use with ColorWise Pro Tools, copy the files to a folder of your choice.

TO INSTALL THE ICC PROFILES ON A WINDOWS COMPUTER FROM THE USER SOFTWARE (DRIVERS) CD

1. Insert the User Software (Drivers) CD into the CD-ROM drive.
2. Open the ICC folder.
3. Right-click the profile that you want, and then click Install Profile.

The profiles are installed automatically to the Windows\System32\spool\drivers\color folder (Windows XP) or WINNT\System32\spool\drivers\color folder (Windows 2000) on your computer.
**Color files**

You can copy additional color files from the User Software (Drivers) CD. Many of the files are PostScript files that you can import and print using Command WorkStation.

**Windows Color Files folder**


PANTONE Book.ps: A 20-page, Letter-size PostScript file that indicates the closest equivalent of PANTONE coated colors that the CX3641MFP can produce. The method used to print the PANTONE Book.ps file differs depending on the Spot Color Matching setting. For more information, see “Spot Color Matching” on page 94.

**RGB page 01.doc**: A Microsoft Word file you can print to view available RGB colors.

**RGB page 02.ppt**: A Microsoft PowerPoint file you can print to view available RGB colors.

**Color Bars folder**

(inside the Windows Color Files folder)

FieryColorBar.eps: Can be used to print a color control bar.

**PS Files folder**

(inside the Windows Color Files\Calibration Files folder)


The numbers in the file names refer to the number of patches on the page. The Custom files allow you to download measurement patches that incorporate the current calibration set of the copier/printer. The Standard files allow you to download standard measurement patches that bypass the current calibration set of the copier/printer.

**NOTE:** These files are provided for expert users and should not be used for day-to-day calibration.

**Halftone Calibration Files folder**

(inside the Windows Color Files\Calibration Files folder)

Images of measurement pages for various calibration instruments and page sizes, used for calibrating the CX3641MFP for different halftone screens. Files are provided for Adobe Photoshop and for other applications.

**NOTE:** For the X-Rite DTP32 Series II densitometer, use the calibration file for the X-Rite DTP32 densitometer.
Configuring the connection

The first time you start ColorWise Pro Tools, you must configure the connection to the CX3641MFP.

**BEFORE YOU BEGIN**

- Print the Configuration page from the copier/printer touch panel and note the IP address of the CX3641MFP.
  
or
  
- Print the Configuration page from Command WorkStation and note the IP address of the CX3641MFP.

This page contains information you need when configuring the connection, such as the IP address. For TCP/IP installations, you can use the Domain Name Server (DNS) name of the CX3641MFP instead of the IP address. Make sure the CX3641MFP is listed in a DNS used by your network. For more information, see the documentation that accompanies your Windows system.

---

**TO CONFIGURE THE CONNECTION FOR COLORWISE PRO TOOLS**

2. If the Choose Printer Device dialog box appears, click Add.
3. Enter the appropriate information for the CX3641MFP.
   
   **Nickname:** Type a name for the CX3641MFP. This name does not have to match the actual Server Name of the CX3641MFP.
**NOTE:** The nickname cannot contain a Tab character.

**Server Name or Server IP address:** Type the IP address (or DNS name) of the CX3641MFP.

**New Device:** Type the device name for the CX3641MFP: 3641A3.

4 When you have typed all the information, click Add.

5 With the device name (3641A3) selected in the Devices list, click OK.

The CX3641MFP appears in the list of Available Servers. The first line of the entry displays the nickname you assigned the CX3641MFP, followed by the protocol. The second line displays the device name.

6 With the device name selected in the list of Available Servers, click Select.

7 If you are prompted for the server password, type the password and click Login.

The ColorWise Pro Tools main window appears.

**Editing the configuration**

Edit the configuration whenever a change to your CX3641MFP or network occurs, such as a server name or IP address change. Change the specific CX3641MFP Setup information before you configure the connection.
TO EDIT THE CONFIGURATION

1. To add a new CX3641MFP, click Add. Configure the Add New Server dialog box as outlined in steps 3 through 5 in the previous procedure.

2. To remove a CX3641MFP, select the CX3641MFP by its nickname and click Remove.

3. To modify information, select the CX3641MFP by its nickname and click Modify. Edit the information in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
Setting up ColorWise Pro Tools on a Mac OS computer

The following sections describe how to install ColorWise Pro Tools and other files and configure the connection on a Mac OS computer.

Installing ColorWise Pro Tools on a Mac OS computer

You can install ColorWise Pro Tools from the User Software (Utilities) CD.

Before you begin each installation, determine where you want to install each item on your hard disk. Otherwise, the software is placed in the “Fiery” folder by default.

TO INSTALL COLORWISE PRO TOOLS ON A MAC OS COMPUTER FROM THE USER SOFTWARE (UTILITIES) CD

1 Insert the User Software (Utilities) CD into the CD-ROM drive.
2 Browse to the folder for your operating system.
3 Double-click the ColorWise Pro Tools installer icon.
4 Follow the on-screen instructions.
5 If prompted, click Quit to close the installer.

Installing the ColorSync profiles

You can copy additional color files from the User Software (Drivers) CD. Use the ICC profiles with applications that support ICC standards, such as Photoshop. For most ICC-aware applications, you must install the files in a folder named Profiles in the Library: ColorSync folder. For use with ColorWise Pro Tools, you can copy the files to a folder of your choice.

TO INSTALL THE COLORSYNC PROFILES ON A MAC OS COMPUTER FROM THE USER SOFTWARE (DRIVERS) CD

1 Insert the User Software (Drivers) CD into the CD-ROM drive.
2 Open the ColorSync folder.
3 Copy the profiles into Library: ColorSync: Profiles.

NOTE: You must be logged in as an administrator.

After you install the ColorSync files, see the ColorSync documentation for setting ColorSync profiles, such as EFIRGB.
**Color files**

You can copy additional color files from the User Software (Drivers) CD. Many of the files are PostScript files that you can import and print using Command WorkStation.

- **Mac Color Files folder**
  - **CMYK Color Reference.ps**: An 11-page, Letter-size PostScript file to use for reference when defining CMYK colors in applications.
  - **PANTONE Book.ps**: A 20-page, Letter-size PostScript file that indicates the closest equivalent of PANTONE coated colors that the CX3641MFP can produce. The method used to print the PANTONE Book.ps file differs depending on the Spot Color Matching setting. For more information, see “Spot Color Matching” on page 94.
  - **RGB page 01.doc**: A Microsoft Word file you can print to view available RGB colors.
  - **RGB page 02.ppt**: A Microsoft PowerPoint file you can print to view available RGB colors.

- **Color Bars folder**
  - (inside the Mac Color Files folder)
  - **FieryColorBar.eps**: Can be used to print a color control bar.

- **PS Files folder**
  - (inside the Mac Color Files: Calibration Files folder)
  - **Custom21.ps, Custom34.ps, Standard21.ps, and Standard34.ps**: PostScript files of color patches for obtaining measurements. The numbers in the file names refer to the number of patches on the page. The Custom files allow you to download measurement patches that incorporate the currently installed calibration set. The Standard files allow you to download standard measurement patches that bypass the currently installed calibration set.

  **NOTE**: These files are provided for expert users and should not be used for day-to-day calibration.

- **Halftone Calibration Files folder**
  - (inside the Mac Color Files: Calibration Files folder)
  - Images of measurement pages for various calibration instruments and page sizes, used for calibrating the CX3641MFP for different halftone screens. Files are provided for Adobe Photoshop and for other applications.

  **NOTE**: For the X-Rite DTP32 Series II densitometer, use the calibration file for the X-Rite DTP32 densitometer.

**Configuring the connection**

The first time you start ColorWise Pro Tools, you must configure the connection to the CX3641MFP.
NOTE: ColorWise Pro Tools is supported only over TCP/IP networks.

BEFORE YOU BEGIN

- Print the Configuration page from the copier/printer touch panel and note the IP address of the CX3641MFP
- Print the Configuration page from Command WorkStation and note the IP address of the CX3641MFP.

This page contains information you need when you configure the connection. For TCP/IP installations, you can use the Domain Name Server (DNS) name of the CX3641MFP instead of the IP address. Make sure the CX3641MFP is listed in a DNS used by your network. For more information, see the documentation that accompanies your Macintosh system.

TO CONFIGURE THE CONNECTION FOR COLORWISE PRO TOOLS

1. Double-click the ColorWise Pro Tools icon.

   The Choose Printer Device dialog box appears.

2. If the No Servers Configured dialog box appears, click OK. If the Choose Printer Device dialog box appears, click Add.
3 Enter the appropriate information for the CX3641MFP.

Nickname: Type a name for the CX3641MFP. It does not have to match the actual server name of the CX3641MFP.

NOTE: The nickname cannot contain a Tab character.

Server name or Server IP address: Type the IP address (or DNS or host name) of the CX3641MFP.

New Device: Type the device name for the CX3641MFP: 3641A3. This device name appears in the Printer Setup section of the Configuration page.

4 When you have typed all the information, click Add.

5 With the device name selected in the Devices list, click OK.

The CX3641MFP appears in the list of Available Servers. The first line of the entry displays the nickname you assigned the CX3641MFP, followed by the protocol. The second line displays the device name.

6 With the device name selected in the list of Available Servers, click Select.

The ColorWise Pro Tools main window appears.

Editing the configuration

Edit the configuration whenever a change to your CX3641MFP or network occurs, such as a server name or IP address change. Change the specific CX3641MFP Setup information before you configure the connection.

To edit the configuration

1 To add a new CX3641MFP, click Add. Configure the Add Server dialog box as outlined in steps 3 through 5 in the previous procedure.

2 To remove a CX3641MFP, select the CX3641MFP by its nickname and click Remove.

3 To modify information, select the CX3641MFP by its nickname and click Modify. Edit information in the Modify Server Settings dialog box and click OK.

The list of Available Servers reflects your modifications.
Using ColorWise Pro Tools

ColorWise Pro Tools gives you flexible control of color printing by allowing you to calibrate the CX3641MFP, customize simulation and output profiles, manage profiles on the CX3641MFP, manage spot colors, and set default values for ColorWise print options.

Using Calibrator

ColorWise Pro Tools Calibrator allows you to calibrate the CX3641MFP using one of a number of measurement methods. For information about calibrating the CX3641MFP, see page 33.

Using Color Editor

ColorWise Pro Tools Color Editor allows you to create custom profiles by editing existing simulation or output profiles, and then saving the changes as a new profile. Use Color Editor to fine-tune a profile on the CX3641MFP to meet your exact specifications. Access Color Editor directly, by clicking its icon in the ColorWise Pro Tools main window, or indirectly, through the Profile Manager.

**NOTE:** You cannot edit source profiles. Only simulation and output profiles can be customized.

**To use Color Editor**

1. Start ColorWise Pro Tools and connect to the CX3641MFP.
2 Click Color Editor.

Simulation lists the simulation profiles resident on the CX3641MFP. Output lists the output profiles resident on the CX3641MFP.

3 Select a profile and click Select.

For more information about Color Editor, see ColorWise Pro Tools Help.
Adjusting gray balance

The AutoGray feature allows you to use the copier/printer’s built-in scanner as a measurement device for adjusting the gray balance of output profiles. Gray balance refers to the quality of neutral gray tones in a profile. In many cases, gray tones may contain a bluish or reddish color cast. AutoGray helps shift these tones back toward neutral grays. If you are satisfied with the gray balance of the copier/printer, you do not need to use AutoGray.

TO CORRECT THE GRAY BALANCE OF AN OUTPUT PROFILE

1. Start ColorWise Pro Tools and click Color Editor.
2. Choose Output from the View list.
3. Select a profile to edit and click Select.
   Or, you can open the Profile Manager, select a profile, and then click Edit, which starts Color Editor.
4. Choose Custom from the Edit Mode menu.
5. Click AutoGray.
6. If the output profile contains no edit points, continue to step 8. If the output profile contains edit points from a previous AutoGray session, choose Refine or New.

**Refine** reuses edits points from a previous session in an attempt to make them more accurate. Refine is optional; use it only if the gray balance in your test document still needs improvements after the first AutoGray session. If two Refine applications cannot fix the situation, it is probably because your test document is not correctly addressing the output profile, or because the output profile that you are editing does not adequately describe the actual copier/printer and printing conditions. Applying Refine more than twice is not recommended.

**New** starts a new AutoGray session by first removing all edit points from a previous session. New is recommended when you have performed more than two Refine applications.

7. If the output profile contains edit points that were entered by a user, choose Proceed to remove the points and continue with the AutoGray adjustment.

Proceed starts a fresh AutoGray session by first removing all user edit points. This is because AutoGray cannot modify user-entered points.
8 In the Print Options dialog box that appears, choose the Input Tray to use for the measurement page and click Print.

![Print Options dialog box]

The Page Type is automatically set to AutoGray Measurement Page.

The Paper Size is automatically set to LTR/A4.

9 Retrieve the measurement page from the copier/printer.

10 Follow the directions in the dialog box for placing the Kodak Gray Scale strip and the AutoGray measurement page on the copier/printer glass, and click Continue.

   Messages display the progress of the gray balance adjustment.

11 When the adjustment is complete, click OK.

   Color Editor displays the adjusted output profile curve. New edit points have been inserted by AutoGray to modify the gray balance, in much the same way an expert user would have done manually.

12 To make edits to the output profile curve, click AutoGray again.

13 Choose Refine to fine-tune the curve, or New to acquire a new curve for editing.

   For more information about these steps, see page 23.

14 To accept the AutoGray adjustment and save the results as a new profile, click Save.

15 Click Done to close Color Editor.
Using Profile Manager

ColorWise Pro Tools Profile Manager allows you to manage and edit ICC profiles.

To use Profile Manager

1 Start ColorWise Pro Tools and connect to the CX3641MFP.

2 Click Profile Manager.

The Profile Manager window appears.

3 Click any profile to select it.

Information about the profile, such as its creation date and ICC specification version, appears at the bottom of the window. Note that ICC specification version 4 profiles (profile version 4.2.0.0) are supported, as well as version 2.

For more information about Profile Manager, see ColorWise Pro Tools Help.

For information about the Use Media Defined Profile option, see “Using media-defined output profiles” on page 26.

For more information about using Device Link Profiles, see page 26.
Setting the default profiles

Use Profile Manager to set a default RGB source profile, simulation profile, or output profile. The default RGB source and simulation profiles that you set are applied to all print jobs sent to the CX3641MFP, unless you override them using print options. The same is true of the default output profile that you set, unless you select the Use Media Defined Profile option.

The Use Media Defined Profile option indicates whether or not to automatically apply the output profile associated with the media type used in a print job. For more information, see the following section.

Using media-defined output profiles

Instead of having Profile Manager apply a default output profile to all your print jobs, you can keep the Use Media Defined Profile option selected. This option automatically applies the output profile predefined for the media type in your print job. If your job contains mixed media, this option can apply different output profiles predefined for the different media.

To use media-defined output profiles

1. Start ColorWise Pro Tools and click Profile Manager.
2. Select Use Media Defined Profile in the Output bar of Profile Manager.

Changing the setting for the Use Media Defined Profile option in Profile Manager automatically changes the same setting in Color Setup. For more information, see “Using Color Setup” on page 30.

About Device Link Profiles

The CX3641MFP supports the use of Device Link Profiles. A Device Link Profile describes the conversion from one color space to another. Device Link Profiles are restrictive because they define the complete conversion from a source device to a destination device. When you print using a Device Link Profile, you do not choose a source profile or an output profile because the Device Link Profile specifies both. ColorWise supports two kinds of Device Link Profiles: RGB source to CMYK destination and CMYK source to CMYK destination.

A Device Link Profile bypasses most ColorWise color management because the information needed to convert from the source to destination is fully contained in a Device Link Profile.

To create a Device Link Profile, use profile-generating software such as EFI Color Profiler Suite.

NOTE: Depending on your job’s workflow, you may not need to use Device Link Profiles.
Installing Device Link Profiles

If you are an administrator, you can download Device Link Profiles to the CX3641MFP using Profile Manager. You must associate a Device Link Profile with the following settings:

- An RGB Source Profile or a CMYK Simulation Profile setting and
- An Output Profile setting

The Device Link Profile is enabled when these two settings are selected.

You can enable a Device Link Profile in three locations:

- In ColorWise Pro Tools Color Setup, select the default settings for RGB Source Profile, CMYK Simulation Profile, and Output Profile. These settings apply to all jobs unless overridden for a particular job.
- Use Expert Color Settings in the CX3641MFP printer drivers to select the settings for RGB Source Profile, CMYK Simulation Profile, and Output Profile when you print a job.
- Use Command WorkStation Job Properties to override the settings for RGB Source Profile, CMYK Simulation Profile, and Output Profile for a specific job.

For more information about enabling Device Link Profiles using Color Setup, see page 31. For more information about enabling Device Link Profiles using Expert Color Settings in the CX3641MFP printer driver see page 99.

TO DOWNLOAD DEVICE LINK PROFILES USING PROFILE MANAGER

1. In Profile Manager, if you do not see the Device Link Profile in the Description list, select the folder that contains the Device Link Profile by clicking Browse in the upper-left corner.

2. Click OK to add the folder contents to the Description list.

The Device Link Profile is added to the Description list.
3 To add the Device Link Profile to the Device Link panel, select the Device Link Profile in the Description list and click the green arrow pointing to the Device Link panel.

The Device Link Profile Settings dialog box appears. To assign settings, see the following procedure.

Assigning Device Link Profile settings
The following Device Link Profile Settings dialog box images depict an RGB Source profile description. If you use a CMYK Simulation profile, the screen will reflect a CMYK Simulation profile description instead of an RGB Source profile description.
TO ASSIGN DEVICE LINK PROFILE SETTINGS

1 After you download the Device Link Profile using Profile Manager and add it to the Device Link Profile panel, select the source and output profiles for this Device Link Profile in the Device Link Profile Settings dialog box.

If the Device Link Profile already has a source and output referenced, the Output and Source Profiles automatically appear.

If the source or output profile referenced in the Device Link Profile is not found on the CX3641MFP, the source profile will show “Unassigned” and a message appears, stating that the source or output profile cannot be found.

Click Information to find out more about the missing profile.

If you install the source or output profile to the CX3641MFP that matches the missing profile referenced in the Device Link Profile, the “Unassigned” setting is automatically updated.

NOTE: If the source or output setting is unassigned, the Device Link Profile cannot be used. You must assign settings.
2 If the Device Link Profile does not have a source or output assigned, select a Profile Description name, and the source and output profiles for the Device Link Profile.

![Device Link Profile Settings](image)

3 When you are finished assigning settings to the Device Link Profile, click OK.

Modifying Device Link Profiles
To modify the Device Link Profile settings, use the following procedure.

**TO MODIFY DEVICE LINK PROFILE SETTINGS**

1 Double-click the Device Link Profile in the Device Link panel.
   The Device Link Profiles Settings dialog box appears.

2 Enter the new Source and Output profiles.

3 Click Apply and then click OK.

**NOTE:** You cannot edit the Device Link Profile in ColorWise Pro Tools. You must use the application that was used to create the Device Link Profile.

**Using Spot-On**
Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents. The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries. Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on the CX3641MFP. For more information about Spot-On, see page 59.

**Using Color Setup**
ColorWise Pro Tools Color Setup allows you to set the default values for the ColorWise print options and print settings for the CX3641MFP.

These settings are applied to all print jobs sent to the CX3641MFP, unless a user overrides them for an individual job by changing settings in the printer driver. These default settings can also be overridden using Command WorkStation. In addition, the defaults set in Color Setup are automatically reflected in other CX3641MFP tools that list default settings.
The options in Color Setup are arranged in a pattern representing the flow of color processing that takes place on the CX3641MFP. To reset the CX3641MFP to its factory default settings, click Factory Default in the lower-left corner of the Color Setup window.

**TO USE COLOR SETUP**

1. Start ColorWise Pro Tools and connect to the CX3641MFP.
2. Click Color Setup.

**New screenshot**

TBD

**Using Color Setup to enable Device Link Profiles**

You can enable Device Link Profiles using Color Setup.

For information about installing and assigning Device Link Profiles, see page 27.
TO USE COLORWISE COLOR SETUP TO ENABLE DEVICE LINK PROFILES

1. Open Color Setup from ColorWise Pro Tools.

2. Select the RGB Source profile or the CMYK Simulation Profile and the Output Profile.

   When you select a source and output combination that is defined as a Device Link Profile, the Device Link Profile is automatically activated.

   When the Device Link Profile is selected, the Color Process workflow updates and some of the Fiery print options may not appear.

   You will see the message “Device Link Profile in use” under the RGB Source Profile or CMYK Simulation Profile.

3. Click OK to exit Color Setup.

New screenshot

TBD
Calibrating the CX3641MFP ensures consistent and reliable color output. Calibrate the CX3641MFP using ColorWise Pro Tools Calibrator with the copier/printer’s built-in scanner, a densitometer or a spectrophotometer.

This document uses the following terminology for color measurement instruments:

<table>
<thead>
<tr>
<th>Term</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>ColorCal with Calibrator</td>
<td>Calibration method that uses the copier/printer's built-in scanner to measure toner density values. You can use Calibrator in ColorWise Pro Tools to perform ColorCal calibration.</td>
</tr>
<tr>
<td>DTP32 or DTP32 Series II</td>
<td>X-Rite DTP32 or DTP32 Series II automatic densitometer</td>
</tr>
<tr>
<td>DTP41</td>
<td>X-Rite DTP41 automatic spectrophotometer</td>
</tr>
<tr>
<td>ED-100</td>
<td>Densitometer ED-100 hand-held densitometer</td>
</tr>
<tr>
<td>ES-1000</td>
<td>Spectrophotometer ES-1000 hand-held spectrophotometer</td>
</tr>
<tr>
<td>ColorCal from the copier/printer touch panel</td>
<td>Calibration method that uses the copier/printer’s built-in scanner to measure toner density values. You can use the copier/printer touch panel to perform ColorCal calibration.</td>
</tr>
<tr>
<td>VisualCal from the copier/printer touch panel</td>
<td>Calibration method that uses a visual inspection of printed output. You can use the copier/printer touch panel to perform VisualCal calibration.</td>
</tr>
</tbody>
</table>

**About this chapter**

This chapter describes the procedures for calibrating the CX3641MFP using ColorWise Pro Tools Calibrator with various color measurement instruments or calibrating from the copier/printer touch panel. The following table provides the location of each procedure.

<table>
<thead>
<tr>
<th>Calibration method</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>ColorCal with Calibrator</td>
<td>page 38</td>
</tr>
<tr>
<td>DTP32 or DTP32 Series II with Calibrator</td>
<td>page 41</td>
</tr>
<tr>
<td>DTP41 with Calibrator</td>
<td>page 43</td>
</tr>
<tr>
<td>ED-100 with Calibrator</td>
<td>page 46</td>
</tr>
<tr>
<td>ES-1000 with Calibrator</td>
<td>page 49</td>
</tr>
</tbody>
</table>
This chapter also describes important concepts and suggestions for understanding calibration. The following table provides the location of each description.

<table>
<thead>
<tr>
<th>Calibration method</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>ColorCal from the copier/printer touch panel</td>
<td>page 52</td>
</tr>
<tr>
<td>VisualCal from the copier/printer touch panel</td>
<td>page 54</td>
</tr>
</tbody>
</table>

**NOTE:** The procedures described in this chapter are fundamentally the same for Windows and Mac OS computers. Illustrations from a Windows computer are used in this chapter.

### Calibrating with ColorWise Pro Tools Calibrator

ColorWise Pro Tools Calibrator allows you to calibrate the CX3641MFP using the measurement method of your choice.

Changing calibration has the potential to affect all jobs for all users, so consider limiting the number of people authorized to perform calibration. Set an Administrator password to control access to calibration (see *Configuration and Setup*).

**NOTE:** Multiple users can be connected to one CX3641MFP with ColorWise Pro Tools, but only one user at a time can use Calibrator. If you try to calibrate when another user is using ColorWise Pro Tools to calibrate, an error message appears.

### Starting Calibrator

Start Calibrator from the ColorWise Pro Tools main window.
TO CALIBRATE THE CX3641MFP USING CALIBRATOR

1 Start ColorWise Pro Tools and connect to the CX3641MFP.

2 Click Calibrator.

3 Choose a method from the Select Measurement Method menu.

New screenshot TBD

Procedures for each calibration method are described in subsequent sections of this chapter.


**Expert mode**

Calibrator provides two modes: Standard and Expert. You can perform all essential calibration tasks while in Standard mode. Expert mode offers two additional options: Print Pages and View Measurements.

**New screenshot TBD**

With the Print Pages option, print Comparison Pages showing the results of the new measurements with any profile associated with the currently selected calibration set. You can create a custom Comparison Page and save it as a PostScript or Encapsulated PostScript (EPS) file called CALIB.PS. Next, print the file to the Hold queue of the CX3641MFP from your application. You can also create a CALIB.PS file by renaming any job in the Hold queue using Command WorkStation (see *Utilities*).

With the View Measurements option, you can view the current set of measurements as a table or graph that shows both the measurements and the target curves.
When more than one profile uses the same target, an additional menu called Plot Against appears in the upper-right corner of the dialog box. It lists all output profiles that use that same calibration set. Selecting an output profile from this menu displays the target curves associated with that profile. If each output profile contains a unique calibration target, the curves displayed also change when you switch profiles.

**Applying measurements to multiple calibration sets**

Calibrator provides an option (Apply to All Calibration Sets) that allows you to copy the measurements from the calibration you are currently performing to all calibrations sets on the server. This option is only available if the CX3641MFP has more than one calibration set. It is selected by default.

If you deselect Apply to All Calibration Sets, you can choose to apply the current calibration to a selected subset of the calibration sets on the server. You specify which sets by clicking Customize next to the Apply to All Calibration Sets option, which displays the Apply To window.

**New screenshot**

**TBD**

Click to select or deselect individual calibration sets, and then click OK.

If any of the selected calibration sets are not associated with an output profile, a warning appears, but you can choose to apply the calibration measurements to that set anyway.

The calibration measurements are copied to the specified calibration sets at the end of the calibration process when you click Apply.

**Restoring default calibration measurements**

Use the following procedure to return to factory default calibration measurements.

**TO RESTORE DEFAULT CALIBRATION MEASUREMENTS**

1. In the Calibrator dialog box, click Restore Device.
2 Click OK to restore the preset default calibration set.

**NOTE:** If Apply to All Calibration Sets is selected, all calibration sets on the server are restored. If Apply to All Calibration Sets is cleared, Restore Device applies only to the calibration sets selected under Customize.

**Calibrating with ColorCal**

ColorCal allows you to calibrate the CX3641MFP without the use of an additional spectrophotometer or densitometer. Instead, ColorCal uses the copier/printer’s built-in scanner to measure toner density values.

ColorCal has the following features:

- **Scanner calibration:** ColorCal lets you calibrate the scanner (copier/printer feeder) using the Kodak Color and Gray Scale strips.

- **Measurement page:** For ColorCal, square black-and-white and color patches are randomly printed on the ColorCal Measurement Page. This allows ColorCal to be less influenced by copier/printer conditions, providing greater accuracy in color reproduction and calibration.

**NOTE:** To calibrate using ColorCal, you will need the Kodak Gray Scale strip included in the customer media pack that came with your CX3641MFP. You also need the Kodak Gray Scale strip and Kodak Color Control Patches strip to calibrate the scanner of the copier/printer for ColorCal.

When you run ColorCal from ColorWise Pro Tools, you have the option to calibrate the scanner before calibrating the CX3641MFP itself. It is recommended to calibrate the scanner for ColorCal when the CX3641MFP output has been adjusted, such as after maintenance or service.

---

**To calibrate with ColorWise Pro Tools and ColorCal**

1 **Start Calibrator.**

   For instructions on starting Calibrator, see page 34.

2 **In the Select Measurement Method pane, choose ColorCal.**

3 **In the Check Print Settings pane, choose an appropriate calibration set.**

   If more than one option appears, choose the appropriate calibration set for the type of media and screen you will use most often.
NOTE: For this calibration to take effect, the calibration set must be associated with one or more output profiles. The default calibration set is already associated with the default output profile, so there is no need to make any new associations.

4 Click Print in the Generate Measurement Page pane.

5 Choose the Page Type.

- ColorCal Page prints one of the 256 ColorCal patterns chosen at random.
- Single Pattern prints a specific pattern. Enter the pattern number in the Patch Page Number field.

The Paper Size is automatically set to LTR/A4.

6 Choose the Input Tray to use for the measurement page.

7 To print the scanner measurement page and calibrate the scanner before calibrating the CX3641MFP, select Print scanner calibration page.

If you clear this option, only the ColorCal measurement page is printed, and the scanner calibration is skipped.

We recommend that you always calibrate the scanner before calibrating the CX3641MFP.

8 Click Print.

A message appears stating the status of your print job.

9 Click OK to continue.

10 Retrieve the ColorCal measurement page (and the scanner measurement page, if you selected it) from the copier/printer.

11 Click Measure in the Get Measurements pane.

12 If you are skipping scanner calibration, go to step 16.
13 Place the Kodak Gray Scale strip, Kodak Color Control Patches strip, and scanner measurement page in the correct positions on the copier/printer glass for scanner calibration.

Place the Gray Scale strip face down on the copier/printer glass so that it is centered along the top edge of the scanner measurement page. Then place the Color Scale strip face down on the copier/printer glass so it is centered below the Gray Scale strip, keeping a distance of 0.25 inch to 0.5 inch between the two strips. Finally, place the scanner measurement page face down over the strips.

14 Click Continue to start the scanner measurement.

When the measurement process completes, the information dialog box appears.

15 Click Continue to complete scanner calibration.

16 Place the Kodak Gray Scale strip face down on the copier/printer glass.

Place the strip along the top edge of the copier/printer so that it is centered between the paper width marks on the copier/printer.

17 Place the ColorCal measurement page face down over the grayscale strip.

Make sure that the patches on the grayscale strip do not overlap the color patches.

Close the platen glass cover, being careful not to move the grayscale strip and color measurement page.
18 Click Continue to start the ColorCal measurement.

![ColorCal dialogue box]

When the measurement process completes, the Measurement dialog box appears.

19 Click OK to complete calibration.

![Measurement dialogue box]

20 To apply the ColorCal calibration, click Apply.

21 To close Calibrator, click Done.

**Calibrating with the DTP32 or DTP32 Series II**

Using the DTP32 or DTP32 Series II densitometer, you can measure color patches generated by the copier/printer and automatically download the measurements to the CX3641MFP.

**Note:** Before you use ColorWise Pro Tools to calibrate the CX3641MFP, set up and calibrate the DTP32 or DTP32 Series II. For instructions, see the documentation that accompanies the instrument.

---

**To Calibrate the CX3641MFP Using the DTP32 or DTP32 Series II**

1 Start Calibrator.

   For instructions, see page 34.

2 In the Select Measurement Method pane, choose X-Rite DTP32 or X-Rite DTP32 Series II.

3 In the Check Print Settings pane, choose a calibration set.

   If more than one option appears, choose the appropriate calibration set for the type of media and screen you use most often.

   **Note:** For this calibration to take effect, the calibration set must be associated with one or more output profiles. The default calibration set is already associated with the default output profile. You do not need to make any new associations.
4 Click Print in the Generate Measurement Page pane.

The Print Options dialog box appears.

5 Choose the appropriate options and click Print.

**Page Type:** Choose 21 or 34 Sorted Patches.

**Paper Size:** Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11x17/A3 or 12x18/SRA3 for 34 Sorted Patches.

**Input Tray:** Specify the paper source.

6 Retrieve the measurement page from the copier/printer.

7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box displays the specified Page Type and Paper Size options.

8 Click Measure.

Follow the on-screen instructions to feed the measurement page through the DTP32.

**NOTE:** The DTP32 Series II does not have an edge guide for the page. Position the page so that the strip to be measured is lined up directly under the alignment mark.

The Status field displays instructions for selecting the port and feeding the measurement page through the DTP32 four times, once for each color strip.
When the Status field indicates that the measurements were read successfully, click Accept.

Click OK in the Measure dialog box.

Click Apply in the Calibrator dialog box to implement the new calibration set.

Click OK in the Information dialog box.

This completes the calibration process.

Calibrating with the DTP41

Using the DTP41 spectrophotometer, you can measure color patches generated by the CX3641MFP and automatically download the measurements to the Fiery.

**NOTE:** Before you use ColorWise Pro Tools to calibrate the CX3641MFP, set up and calibrate the DTP41. For instructions, see the documentation that accompanies the instrument.

**TO CALIBRATE THE CX3641MFP USING THE DTP41**

1. Start Calibrator.
   
   For instructions, see page 34.

2. Choose X-Rite DTP41 as the measurement method.

3. In the Check Print Settings pane, choose a calibration set.
   
   If more than one option appears, choose the appropriate calibration set for the type of media and screen you use most often.

   **NOTE:** For this calibration to take effect, the calibration set must be associated with one or more output profiles. The default calibration set is already associated with the default output profile. You do not need to make any new associations.

4. Click Print in the Generate Measurement Page pane.
   
   The Print Options dialog box appears.
5 Choose the appropriate options and click Print.

Page Type: Choose 21 or 34 Sorted Patches.

Paper Size: Automatically set to LTR/A4 for 21 Sorted Patches. Choose 11x17/A3 or 12x18/SRA3 for 34 Sorted Patches.

Input Tray: Choose the paper source for printing the measurement page.

6 Retrieve the measurement page from the copier/printer.

7 In the Get Measurements pane, click Measure.

The Measurement Options dialog box displays the specified Page Type and Paper Size options.

8 Click Measure.

9 If necessary, choose the appropriate COM port for the DTP41 from the Available Ports menu, and then click Start Measurements.
10 Feed the measurement page into the DTP41, starting with the cyan strip.

Align the page in the measurement page slot of the DTP41 so that the appropriate color column is centered below the alignment mark. Insert the page about three inches, past the front idler rollers, until it rests against the rear drive rollers and you feel resistance.

11 Click Read Strip.

The DTP41 pulls the measurement page through automatically.

After the measurement page is read, Calibrator instructs you to insert and align the page again for the next color.

12 Repeat the measurement process for the magenta, yellow, and black strips.

A check mark appears on the circle of the color just read, and the Status field indicates the color was measured successfully.

Use the Previous and Next buttons to reverse or advance to another step in the measurement sequence.

13 When the Status field indicates that all four color strips have been read successfully, click Accept Measurements.

14 Click OK in the Measure dialog box.

15 Click Apply in the Calibrator dialog box to implement the new calibration set.
16 **Click OK in the Information dialog box.**

This completes the CX3641MFP calibration process.

**Calibrating with the ED-100**

You can use ColorWise Pro Tools in conjunction with the ED-100 to calibrate the CX3641MFP.

**NOTE:** You need to calibrate the copier/printer every time you use the ED-100.

---

**TO CALIBRATE THE CX3641MFP USING THE ED-100**

1 **Start Calibrator.**

For instructions on starting Calibrator, see page 34.

2 **Choose EFI Densitometer ED-100 as the measurement method.**

3 **In the Check Print Settings pane, choose a calibration set.**

   If more than one option appears, choose the appropriate calibration set for the type of media and screen you use most often.

   **NOTE:** For this calibration to take effect, the calibration set must be associated with one or more output profiles. The default calibration set is already associated with the default output profile, so there is no need to make any new associations.

4 **In the Generate Measurement Page pane, click Print.**

The Print Options dialog box appears.

5 **Choose the appropriate options and click Print.**

![Print Options dialog box](image)

**Page Type:** Choose either 34 or 21 Sorted Patches, or 34 or 21 Randomized Patches. Sorted patches are printed on the page in the order of their hue and saturation levels. Randomized patches are printed on the page in random order, to help compensate for density inconsistencies on different areas of the page.

**Paper Size:** Automatically set to LTR/A4 for 21 patches. Choose 11x17/A3 or 12x18/SRA3 for 34 patches.

**Input Tray:** Specify the paper source for printing the measurement page.
6 Retrieve the measurement page from the copier/printer.

7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.

8 Choose the appropriate options, and then click Start.

Page Type is automatically set to the measurement page type that you printed in step 5.

Use the arrow buttons next to the Clicks Per Patch field to choose the number of measurements you want to take for each patch on the page. When you choose multiple clicks, the average value of all measurements taken for the patch is returned to the CX3641MFP. Multiple measurements are more accurate, but may take more time.

To hear a confirmation tone each time a measurement is recorded, select the Audio Feedback option. A single tone indicates a successful measurement. Two tones indicate a measurement error. If you have specified multiple clicks per patch, the tone sounds after you take the final measurement.

If necessary, choose the appropriate COM port for the ED-100 from the Port menu.

When you click Start, the Measurements window appears. Directions for measuring the patches appear in the Status area.
9 Place the ED-100 over the specified patch on the Measurement Page, making sure to center the sample aperture over the patch. Press Measure to take the measurement.

**NOTE:** For a more accurate measurement, place several plain sheets of paper beneath the Measurement Page to block underlying colors from being read by the instrument.

If you have specified multiple clicks per patch, continue pressing Measure to take the required number of measurements. We recommend that you move the ED-100 slightly after each measurement while keeping it within the patch circle.

When the patch has been measured successfully, a check mark appears in the patch preview in the Measurements window. The window identifies and highlights the next patch to be measured.

10 Repeat step 9 to measure each successive patch on the Measurement Page.

Start with A1 and continue down Column A. When you have finished measuring all the patches in Column A, proceed to Column B in the same manner until all columns have been measured.

To retake a measurement, select the desired patch preview in the Measurements window and measure the patch on the page using the ED-100.

**NOTE:** You must take the measurements in the order outlined in the Measurements window and on the measurement page.

11 When all the patches have been read successfully, click Accept.

12 Click Apply in the Calibrator dialog box.

The new calibration measurement is implemented.

13 Click OK in the Information dialog box.

This completes the CX3641MFP calibration process.
Calibrating with the ES-1000

Use ColorWise Pro Tools in conjunction with the ES-1000 spectrophotometer to calibrate the CX3641MFP.

**NOTE:** Before you use ColorWise Pro Tools to calibrate the CX3641MFP, set up and calibrate the ES-1000. For instructions, see the documentation that accompanies the instrument.

**To Calibrate the CX3641MFP Using the ES-1000**

1. **Start Calibrator.**
   
   For instructions, see page 34.

2. **Choose ES-1000 as the measurement method.**

3. **In the Check Print Settings pane, choose a calibration set.**
   
   If more than one option appears, choose the appropriate calibration set for the type of media and screen you use most often.

   **NOTE:** For this calibration to take effect, the calibration set must be associated with one or more output profiles. The default calibration set is already associated with the default output profile. You do not need to make any new associations.

4. **Click Print in the Generate Measurement Page pane.**
   
   The Print Options dialog box appears.

5. **Choose the appropriate options and click Print.**

   ![Print Options Dialog](image)

   **Page Type:** Choose 21 or 34 Sorted Patches or 21 or 34 Randomized Patches. Sorted patches are printed on the page in the order of their hue and saturation levels. Randomized patches are printed on the page in random order, to help compensate for density inconsistencies on different areas of the page.

   **Paper Size:** Automatically set to LTR/A4 for 21 patches. Choose 11x17/A3 or 12x18/SRA3 for 34 patches.

   **Input Tray:** Automatically set to Auto Select.
6 Retrieve the printed measurement page from the copier/printer.

7 Click Measure in the Get Measurements pane.

The Measurement Options dialog box appears.

Page Type is automatically set to the type that you selected in step 5.

8 Check the settings and click Measure.

The Information dialog box appears.

9 Place the ES-1000 in the calibration cradle.

When you place the ES-1000 in the calibration cradle, white point calibration is used to calibrate the spectrophotometer and compensate for gradual drifts in the instrument. Make sure the sample aperture is in full contact with the white tile on the calibration cradle. If you do not place it correctly in the calibration cradle, the spectrophotometer does not return accurate measurements.

10 Click OK.

The Measurements dialog box appears. Instructions for measuring the strips appear in the Status field.
11 For a more accurate measurement, place several sheets of plain white paper beneath the Measurement Page.

The extra sheets block underlying colors from being read by the instrument.

12 Orient the Measurement Page so that strips are horizontal and the scan direction (indicated by the arrows at the beginning of each strip) is left to right.

13 Hold the ES-1000 with its length perpendicular to the scan direction, and place the sample aperture in the white space at the start of the specified color.

14 Press and hold the Measure button and wait for a beep or wait for the background color in the dialog to change from green to white.

**NOTE:** To hear a beep with a Windows compatible computer, you must install a sound card and speaker(s). You may have to turn up the volume on your computer to hear the beep.

15 After you hear a beep or see the dialog background color change, slide the ES-1000 at a slow but consistent pace across the strip.

Take about five seconds to slide the length of the strip.

16 Release the button when all the patches in the strip have been measured and you reach the white space at the end of the strip.

When a strip is measured successfully, the dialog box background color changes to green, and the cross hair moves to the next color. If the strip is not measured successfully, the dialog box background color changes to red, and a message directs you to try again.

17 Repeat steps 13 through 16 until all the strips are measured.

**NOTE:** You must measure in the order outlined in the Status field.

18 When all the patches have been read successfully, click Accept.

19 Click Apply in the Calibrator dialog box.

The new calibration measurement is applied.

20 Click OK in the Information dialog box.

This completes the CX3641MFP calibration process.

**Calibrating from the copier/printer touch panel**

You can also calibrate the CX3641MFP from the scanner panel using ColorCal or VisualCal, without using ColorWise Pro Tools Calibrator. Use ColorCal if your copier/printer has a built-in scanner. Use VisualCal if it does not.
Calibrating with ColorCal

If an Administrator password has been set, you will need it to perform calibration from the copier/printer touch panel. For instructions on using the copier/printer touch panel, see Configuration and Setup.

It is also possible to remove calibration measurements from the CX3641MFP. In general, it is not necessary, because any new calibration replaces the existing one if the same calibration set is selected.

To use ColorCal from the copier/printer touch panel

1. At the Idle screen, press Menu to enter the Functions menu.
2. Using the up and down arrow buttons and the Line Selection buttons, choose Calibration, and then choose Set Up Calibration.
   If a password is set on the CX3641MFP, enter it and press OK.
3. For Calibration Mode, choose Standard or Expert.
   With Expert Mode, you can print a Comparison Page (see page 36).
4. For Page Type, choose ColorCal Measurement Page or ColorCal Single Pattern.
   - ColorCal Measurement Page prints one of the 256 ColorCal patterns chosen at random.
   - ColorCal Single Pattern prints a specific pattern.
5. Enter the number of copies to print.
6. For ColorCal Single Pattern, enter the Patch Page number.
7. For Tray, choose the paper source for the patch page.
   Choose Auto Select or Manual Feed.
   **Note:** If you print a measurement page from the Manual Feed tray, you must load the appropriate paper in the tray and select the correct paper size from the copier/printer touch panel display.
8. Choose Calibrate.
9. Select the Calibration Set.
   Choose from the list of all calibration sets on the CX3641MFP. This prompt appears only if more than one calibration set is available.
10. Choose Yes to print the measurement page.
    This page is comprised of swatches of color that will be measured by the copier/printer’s scanner and then compared to the target color values. After the page is printed, the Measure Page screen appears.
12 When prompted on the copier/printer touch panel, place the Kodak Gray Scale strip face-down on the copier/printer glass.

Place the strip along the top edge of the copier/printer so that it is centered between the paper width marks on the copier/printer.

13 Place the color measurement page face-down over the grayscale strip.

Make sure the patches on the grayscale strip do not overlap the color patches.

Close the platen glass cover, being careful not to move the grayscale strip and color measurement page.

14 On the copier/printer touch panel, choose OK.

Status messages display the progress of scanning and calculating measurements.

15 When prompted to Print Comparison Page (Expert Mode only), choose Yes to print a preview of the selected calibration.

Choose from a list of output profiles that use the same calibration set and press OK. This option appears only in Expert Mode calibration.

16 When prompted to apply or overwrite the calibration, choose Yes.

17 Choose Yes to confirm.

Status messages display progress information. When calibration is complete, the copier/printer touch panel display returns to the Functions menu.

### To Remove Calibration from the Copier/Printer Touch Panel

1 From the copier/printer touch panel, access the Calibration menu as described on page 52.

2 Choose Remove Calibration.

3 When prompted, verify that you want to proceed with removing calibration.

The current measurements are removed and a default calibration is restored.
Calibrating with VisualCal

VisualCal is a calibration method that allows you to calibrate your copier/printer to a color output standard defined by the manufacturer. The calibration calculations performed by the controller software are based on a series of values entered on the copier/printer touch panel. The values used in the calculations are determined by evaluating toner densities and color combinations produced on two specially designed calibration pages printed from the copier/printer touch panel.

Limits and 30% Match

The first VisualCal page, “Limits and 30% Match,” provides the basis for calculating the most acceptable luminosity (brightness) of the toners. This page consists of rows of CMYK dots in a graduated range of toner densities.

The variables needed to recalculate the density of the colored toners are determined by identifying the leftmost dots that can be fully distinguished against their fields in each row, and sequentially entering their corresponding numeric values on the copier/printer touch panel. The variable needed to recalculate the luminosity of the toners is determined in a slightly different way—you identify the black dot that best matches a 30% dot gain field. When all values have been entered, the printer’s toner density and luminosity settings are recalculated.

Gray Balance

The second VisualCal page, “Gray Balance,” provides the basis for calculating a “neutral gray balance,” that is, a CMY gray that as closely as possible matches a pure K (black) gray produced by the printer’s engine. This page consists of rows of CMY gray patches on a field of gray produced solely from black. The variables needed to calculate the printer’s most neutral gray balance are determined by identifying the CMY patch that best matches this field, and entering its row and column location on the copier/printer touch panel. When the values have been entered, the printer’s gray balance is recalculated.

To Perform VisualCal Calibration

1. At the Idle screen, press the Menu button to enter the Functions menu.
2. Choose Calibration, and choose Set Up Calibration.
   - If a password is set on the CX3641MFP, enter it and press OK.
3. For Calibration Mode, select Standard or Expert.
   - With Expert Mode, you can print a Comparison Page (see page 36).
4. For Measurement Method, choose VisualCal.
5. For Tray, choose Auto Select or Manual Feed.
6. At the main calibration screen, select Calibrate.
7. For Calibration Set, choose Default, Custom-A, or Custom-B.
8 For Gradation Smoothing, choose Off, Fine, or Coarse.

9 Press Yes to print the Limits and 30% Match page.

To reset the printer’s toner density and luminosity settings, follow the instructions provided on the Limits and 30% Match page. Use the touch screen to change numbers; do not use the numerical keypad.

**NOTE:** Zero (0) and 9 are unacceptable values for color calibration. If you select 0 for any of the colors, the resulting calibration will be inaccurate. If the entered value for any color is 9, the Limits and 30% Match page is reprinted automatically. Re-enter values for all color rows starting with Black Start.

When you have finished entering all values, the Print Grays screen appears.

10 Press Yes to print the Gray Balance page.

To reset the printer’s gray balance, follow the instructions provided on the Gray Balance page. When you have finished entering all values, the Print Color Test screen appears.

**NOTE:** If the Gray Balance page is printed after the Limits calculations have been made, the gray field on which the CMY patches appear on the Limits page will use the new density and luminosity calibration settings.

11 Select Yes to print a color test page that uses the original values (Current Color Test Page) and a Color test that uses the new values (New Color Test Page), and use the up and down arrows to select YES. Press Enter to print the pages.

12 If you are satisfied with the printer’s calibration based on the new values, select YES from the APPLY CHANGES screen that appears, and press OK to calibrate the printer based on the previously entered values.

13 Choose Exit Calibration to return to the Functions menu.

Use the following suggestions for adjusting VisualCal for your specific preferences:

- If your prints seem to be color balanced but too dark, enter a lower value for the 30% Match entry on the Limits and 30% Match page, last row.
- If your prints seem too light, enter a higher value.
- If light areas on your prints have a color cast, enter a lower value in the Start row for that toner.
- If dark areas on your prints have a color cast, enter a higher value in the End row for that toner.
Understanding calibration

The following sections describe important concepts and suggestions for understanding calibration.

An overview of calibration

Calibration generates curves that adjust for the difference between the actual toner densities (measurements) and the response expected by the output profile.

- Measurements represent the actual color behavior of the copier/printer.
- Calibration sets are sets of measurements that combine media and screen options provided for Calibrator.
- Each output profile contains a calibration target that describes the expected behavior of the copier/printer.

After you calibrate the CX3641MFP, a calibration set is stored. This calibration set is used when it is associated with an output profile. Every output profile has an associated calibration set. If you have not specified one, the calibration set associated with the default output profile is used.

If you change the calibration after a saved job has been processed (RIPped), you do not have to reprocess (reRIP) the job. The new calibration affects the job without reprocessing.

NOTE: Changing calibration has the potential to affect all jobs for all users, so consider limiting the number of people authorized to perform calibration. Set an Administrator password in CX3641MFP Setup to control access to calibration (see Configuration and Setup).

How calibration works

Although the needs of most users are met by the default calibration set, the CX3641MFP allows you to choose a calibration set to customize calibration for specialized jobs.

Calibration allows you to:

- Maximize the color reproduction capabilities of the CX3641MFP.
- Ensure consistent color quality over time.
- Produce consistent output across CX3641MFP servers.
- Achieve better color matches when reproducing spot colors, such as PANTONE colors or other named color systems.
- Optimize the CX3641MFP for using ColorWise rendering styles (CRDs), CMYK simulations, and ICC profiles.
Success in obtaining satisfactory print quality from the CX3641MFP depends on many factors. Among the most important are establishing and maintaining optimal toner densities. The **density** is the measure of the light absorbed by a surface. By carefully regulating toner densities, you obtain consistent printed color.

Even with a calibrated system, toner density is affected by the settings of copier/printer, humidity, and temperature. Density also tends to drift over time. Uneven toner density on paper affects calibration results. Regular measurement detects day-to-day variations in density, gradation, and color reproduction, and calibration corrects them.

Calibration works by creating calibration curves on the CX3641MFP that compensate for the difference between actual (measured) and desired (target) density values. These calibration curves are the graphic equivalent of transfer functions, which are mathematical descriptions of changes that are made to the initial data. Transfer functions are often graphed as input or output curves.

The CX3641MFP generates calibration curves after comparing measured values to the final target values for each of the four toner colors. The target values are based on the output profile specified.

**Measurements**

Measurement files contain numerical values that correspond to the toner density produced by the copier/printer when it prints solid cyan, magenta, yellow, and black, and graduated tints of those colors.

To create a measurement file, print a page of color patches. Measure the patches using a color measurement instrument connected to a computer on the network, or if it is available, the print device’s scanner. The new measurements are automatically downloaded to the CX3641MFP.

**Output profiles and calibration sets**

Output profiles and calibration sets define desired calibration results. One or more output profiles and calibration sets are provided with the CX3641MFP. When you calibrate the CX3641MFP, select the calibration set that corresponds to the typical printing jobs at your site. This same calibration set can be associated with one or more output profiles. For more information about output profiles, see page 91.
Scheduling calibration

Calibrate the CX3641MFP at least once a day, depending on the volume of print jobs. If it is very important to maintain consistent color, or your copier/printer is subject to wide fluctuations in temperature or humidity, calibrate every few hours. For optimal performance, calibrate whenever there is a noticeable change in print quality or printing results are not as expected.

If you must split a print job into two or more batches to print at different times, it is important to calibrate before you print each batch. You should also calibrate the CX3641MFP maintenance. However, because the CX3641MFP may be less stable immediately after maintenance, wait until you have printed approximately 50 pages before you calibrate.

**NOTE:** Because printed output from the copier/printer is very sensitive to changes in temperature and humidity, do not install the copier/printer near a window, in direct sunlight, or near a heater or air conditioner. Paper is also sensitive to climate changes. Store it in a cool, dry, stable environment, and keep reams sealed until they are used.

To monitor print quality, print the following color pages:

- Color Charts (from Command WorkStation or the copier/printer touch panel)
- Color reference pages included in the User Software (Drivers) CD (see pages 12 and 17)

These pages include fully saturated color patches and pale tints of cyan, magenta, yellow, and black. Images with skin tones offer a good basis for comparison. Save and periodically compare the pages you print. If a noticeable change in appearance occurs, calibrate the CX3641MFP.

When you examine the Test Page, all color patches should be visible, even though they may be very faint in the five to two percent range. Each patch set should show uniform gradation from patch to patch as the color lightens from 100% to zero.

If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated over time, show the pages to your copier/printer service technician to determine whether adjusting the copier/printer can improve output.

Checking calibration status

To verify whether the CX3641MFP is calibrated, which calibration set and output profile were used, and when the copier/printer was last calibrated, perform the following:

- Print a Configuration page or Test Page from the copier/printer touch panel or Command WorkStation.
- Select a calibration set in Calibrator. The last calibration and the user who performed it are displayed.
The Spot Color Matching print option automatically matches spot colors with their best CMYK equivalents so that spot colors can be simulated using the CMYK toner of the copier/printer. However, you may want to adjust the default CMYK equivalents to achieve a better match for your specific printing conditions. You can modify spot colors using Spot-On.

In addition to managing “named” colors, Spot-On allows you to create a list of “substitute” colors. These are colors that, when called for in a document by their RGB or CMYK values, are substituted with a different color having the CMYK values from the Spot-On color dictionary. This permits exact color control and overrides individual RGB and CMYK colors.

Using Spot-On

Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents. The matching lists of spot colors and CMYK values are known as Spot Color Dictionaries. Spot-On allows you to maintain multiple Spot Color Dictionaries for each output profile on the CX3641MFP.

**NOTE:** Spot-On is an optional feature for the CX3641MFP.

**NOTE:** To use the Spot-On features with named colors, you must enable the Spot Color Matching print option. For more information about this option, see page 94.

**NOTE:** Spot colors identified by names are printed with their defined CMYK values. The edits to the output profile made with Color Editor do not affect how spot colors print.

Some Spot-On features require that a job be displayed with correct colors on your monitor. To display the colors correctly on your monitor, you must set up the monitor display according to the manufacturer’s recommendations, and specify the correct monitor profile for your monitor.

Specify the following settings for the monitor display:

- At the monitor: Brightness, Contrast, and Temperature
- From the control panel of the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up your monitor and the monitor profile, see the documentation that accompanies the monitor.
Starting Spot-On

To use Spot-On, you must specify the output profile associated with the Spot Color Dictionary that you want to edit.

If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using Spot-On, you will get 50%M when you print a job with Output profile X. If you print a job with Output profile Y, you will get the original value. If you select Output profile X and create a custom color named “My Purple” and define it as 80C 40M, ColorWise automatically calculates the Lab values using Output profile X and creates new CMYK values for use with Output profile Y.

**NOTE:** The CX3641MFP allows only one user to connect to Spot-On at a time.

**TO START SPOT-ON**

1. Start ColorWise Pro Tools and connect to the CX3641MFP.

2. Click Spot-On.

   The Select Output Profile dialog box appears.

3. Choose an output profile and click OK.

   The Spot-On main dialog box appears. The CMYK values displayed in the dialog box are calculated with respect to the specified profile.

   **NOTE:** When you print a job, choose the same output profile from the printer driver as the one that is selected in the Select Output Profile dialog box. Otherwise, color adjustments based on Spot-On have no effect.
Spot-On main window

The Spot-On main window list color groups that represent libraries of spot colors on the CX3641MFP. Tool icons for working with colors appear at the top of the window.

By default, the CX3641MFP includes several PANTONE libraries along with a System library. These factory default libraries appear marked with the default group icon ( ).

The DIC, HKS, and TOYO libraries are also available with Spot-On.

You can add custom color groups and colors to the Spot-On window (see page 63). Added groups appear marked with the custom group icon ( ). Both default and custom groups can be opened to display included colors.
To Open and Close a Color Group

1. To open a color group, click the icon to the left of the group name.

When you open a group, all the colors in the group are displayed, and the group icon changes appearance.

2. To close a color group, click the icon to the left of the group name.

3. To close all the color groups in the list, choose Close All from the Edit menu.

Working with existing colors

Spot-On allows you to view and manage existing groups of colors on the CX3641MFP and search for a particular color in the Spot-On list.

Color groups in the Spot-On window appear in order of their priority. Highest priority is assigned to color groups at the top of the list. For instance, if two colors from two different color groups have the same name, the CX3641MFP uses the color from the higher group and disregards the other color. By managing the priority of colors in this way, you can maintain several CMYK variants for the same spot color.

To Rearrange the Priority of Colors

1. To rearrange an entire color group, select the desired color group.

To rearrange an individual color, select the desired color.

Individual spot colors are marked with circular color icons.

2. To move the selection up or down in the list, click the Up or Down icon in the toolbar.

3. To paste the selection in a different location in the list, click the Cut or Copy icon in the toolbar.
NOTE: The Cut operation is available only for custom colors.

4 Click the location in the list where you want to paste the cut or copied selection, and then click the Paste icon in the toolbar.

When you paste a default PANTONE color or group, a warning message appears asking you to rename the selection because of the multiple prefixes and suffixes for the PANTONE colors and groups. Use the menus to choose the desired prefix and suffix for the new name, and then click OK. The pasted selection becomes a custom color or group with the specified name.

TO FIND A SPECIFIC COLOR

1 Choose Find from the Edit menu.

The Find dialog box appears.

2 Enter the name of the color that you want to find and click OK.

Spot-On searches for the specified color, starting from the top of the color list. Once located, the color appears selected in the color list.

3 To find additional colors based on the same search criteria, choose Find Again from the Edit menu.

Creating custom colors

Spot-On provides a number of default color groups in the color list. You can add your own custom spot colors and groups to the list.

TO ADD A NEW COLOR OR COLOR GROUP

1 Select the location in the group or color list where you want the addition to be placed.

2 Choose New Group from the Edit menu to insert a new group, or choose New Color to insert a new color.

A new color group entry or color entry appears as Untitled.

TO RENAME A CUSTOM COLOR OR GROUP

1 Select the specific color or group that you want to rename.
2 Double-click the name of the color or group.

3 Type the new name exactly as it appears in the job, including uppercase and lowercase characters and spaces, as needed.

This new name is supplied by the source application (such as Adobe Illustrator or QuarkXPress) to your PostScript job.

**NOTE:** Default groups or colors (such as PANTONE) cannot be renamed.

### Downloading custom color groups

You can download custom color groups from your computer to the CX3641MFP. Downloaded groups are added as custom groups to the Spot-On color list and are immediately enabled for use on the CX3641MFP.

**TO DOWNLOAD CUSTOM COLOR GROUPS**

1 Select the location in the color list where you want to add the downloaded group.

2 Choose Download from the File menu.

The Select file dialog box appears.

![Select file dialog box](image)

**NOTE:** Although many ICC profiles may be shown, you can only download an ICC Named Color Profile.

3 Locate and select the desired color group, and then click Open.

The downloaded group is added to the specified location in the Spot-On list. If you did not specify a location, the group is added to the top of the list.

If the downloaded group has the same name as an existing group in the list, you are prompted to rename the downloaded group.
Uploading custom color groups

You can upload custom color groups from the CX3641MFP to your computer as ICC files. The upload feature allows you to share a group by creating a local copy that can be downloaded to another CX3641MFP.

You must save a color group to the CX3641MFP before you can upload it to your computer. To upload a factory default group, copy and paste the group as a new custom group, and then upload the group as required.

To upload custom color groups

1. Select the name of the color group you want to upload.
2. Choose Upload from the File menu.

The Save As dialog box appears.

3. Browse to the location where you want to save the file, name the file, and then click Save.

Editing color values

If an existing spot color is not printing as intended, edit the color values as needed to achieve your intended result. Edit color values by entering the exact CMYK values in the Spot-On main window or in the Set Center Patch Color dialog box, or using the Spot-On Color Search feature.

Use the following procedures to edit a named color by entering the exact CMYK values. To target a color using Spot-On Color Search, see page 68.

To edit a color in the Spot-On main window

1. Select the color you want to edit.
2. Double-click the value under C, M, Y, and K, and enter a new number for each color channel.

The edited color appears in the color list.

**NOTE:** The edited color is not saved until you choose Save from the File menu.

---

**TO EDIT A COLOR IN THE SET CENTER PATCH COLOR DIALOG BOX**

1. Select the color you want to edit.

2. Double-click the color icon.

   The Spot-On Color Search dialog box appears with the selected color in the center.

3. Click the center patch.

   The Set Center Patch Color dialog box appears.

4. Indicate whether you want to enter CMYK values as percentages or Device Codes.

   The Percentages option allows you to enter color values between 0 and 100%, in increments of 0.5. Values out of this range are rounded to the nearest whole or half percentage.

   The Device Codes option allows you to enter color values between 0 and 255. This option reflects the full range of color values that the CX3641MFP can reproduce and provides finer gradations of color than are possible with Percentages.

5. Enter the C, M, Y, and K values of your specific color in the appropriate fields.

   Use the Tab key to move from field to field. As you enter each new value, the preview patch updates to reflect the old and new colors.
6 Click OK.

The new color is displayed in the center of the Spot-On Color Search dialog box.

7 Click OK.

The edited color appears in the color list of the Spot-On main window.

Use the following procedure to target a color using the Spot-On Color Search dialog box. Beginning with an approximate color in the Spot-On Color Search dialog box, adjust the hue, saturation, and lightness of the color until you achieve an acceptable match.
TO TARGET A COLOR USING SPOT-ON COLOR SEARCH

1 Select the color that you want to edit.

2 Double-click the color icon.

The Spot-On Color Search dialog box appears with the current color in the center.

3 To update the center patch to a neighboring color that more closely matches the target, click the corresponding neighbor patch.

   Neighboring patches represent variations from the center patch and can be selected if they offer a closer match to the desired color. Clicking one of these patches updates the center patch to the new color and provides a new selection of neighboring colors. These patches are either lightness or saturation neighbors, depending on the option you choose in the following step.

   NOTE: When you select certain colors, an exclamation point icon may appear in the upper-right corner of the dialog box. This icon indicates that one or more colorants have reached their maximum values.

4 Use the following techniques to control how neighboring color patches are generated:

   Select Lightness or Saturation in the Color Directions Legend.

   Lightness generates neighbor patches based on darker to lighter shades of the original color. This variation is displayed from left to right, with the original color remaining in the center of the middle group.

   Saturation generates neighbor patches based on less saturated to more saturated variations of the original color. This variation is displayed from left to right, with the original color remaining in the center of the middle group.

   Choose a setting from the Color Spacing menu to control the closeness of the neighbor patches.

   A higher setting generates neighbor patches that differ more noticeably from the center color. As you get closer to your target color, reduce the color spacing to a smaller value.
Select Monitor Compensation to simulate how all the on-screen color patches will appear when printed on paper.

This simulation depends on the monitor profile that has been configured for your monitor. To specify the monitor profile, choose Preferences from the Edit menu in the Spot-On main window.

Make sure that you set your monitor according to the manufacturer’s recommendations and select the correct monitor profile for your monitor.

5 Continue adjusting the color patch controls and clicking neighbor patches until the color you want appears in the center patch.

6 Click Print Pattern.

**NOTE:** It is very difficult to accurately match spot colors on a monitor. You should always test print to get the proper color match.

7 Choose the appropriate settings from the Output Style, Paper Size, and Paper Tray menus.

For Output Style, choose Color Search Pattern or Color Neighbor Pattern. Color Search Pattern prints patches with the same pattern as displayed in the Color Search dialog box. Color Neighbor Pattern prints patches in a three column by eight row format.

For Paper Size, choose the size of the paper that you want to use for printing the patches.

For Paper Tray, specify the paper source for the paper that you want to use.

8 Click OK to print the patches.

The Print Pattern test page provides the following information:

- Center patch color CMYK value
- Color spacing
- Lightness or Saturation neighbors selected
- Output profile selected

The goal of Spot-On Color Search is to find the color values that make a printed color patch match a target, not its screen simulation of it. Printing a Print Pattern of neighbor color patches allows you to compare the printed patches to the color target. After you compare the printed patches and find the one that matches most closely, you can select the corresponding patch on-screen.
9 Select the desired target color in the Spot-On Color Search dialog box and click OK.

The edited color appears in the color list of the Spot-On main window.

**Using a measurement instrument to target colors**

If you have the Densitometer ED-100 or Spectrophotometer ES-1000, you can import measured color values directly into Spot-On. This feature allows you to target matches based on the actual colors of immediate objects, such as the red of a printed logo or the yellow of a packaging envelope.

For best results, download and save any measurement data you have gathered with the ED-100 in its offline state. Spot-On automatically clears stored data when it establishes a connection with the instrument. For information about downloading stored data from the ED-100, see the documentation that accompanies the instrument.

---

**To import color measurements into Spot-On**

1 Install and set up the ED-100 or ES-1000 for use with your computer.

For installation and setup instructions, see the documentation that accompanies the instrument.

2 Choose Start from the Instrument menu in the Spot-On main window.

The Choose Instrument dialog box appears.

3 For Instrument, choose the instrument you will use to take measurements. For Port, choose the serial port connection of the instrument. Click OK.

For the ED-100, the indicator light on the instrument flashes for a few moments as the connection to Spot-On is established. When the flashing stops, the instrument is ready to read measurements.

4 Place the ED-100 or ES-1000 over the target color, making sure to center the sample aperture over the color. Press Measure to take the measurement.

The measured CMYK values are imported into Spot-On as follows:

- If an individual color is selected in the color list, it updates to the measured color.
- If a group is selected in the color list, a new color with the measured values is created within the group.
- If the Spot-On Color Search dialog box is open, the center patch updates with the measured values, and the neighbor patches update accordingly.
- If the Set Center Patch Color dialog box is open, the measured values are imported into the CMYK entry fields.

5 When you are finished taking color measurements, choose Stop from the Instrument menu.

Spot-On closes the connection to the instrument.
Reverting default colors to factory settings
You can revert default colors to their factory default settings. Revert all colors within a
default color group, or revert one or more specific colors within a default color group, so
that only those colors are reset to the factory default settings.

TO REVERT ALL COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that you want to revert.
2 Choose Revert Group from the File menu.
   A warning message appears.
3 Click OK.

TO REVERT SPECIFIC COLORS WITHIN A DEFAULT COLOR GROUP TO FACTORY DEFAULTS
1 Click the icon to the left of the name of the group that contains the colors you want to
   revert.
2 Select the colors that you want to revert to the factory defaults.
   To select more than one color, Shift-click to select an adjacent color or Control-click to
   select a nonadjacent color.
3 Choose Revert Factory Color from the File menu.
   A warning message appears.
4 Click OK.

Saving changes and exiting Spot-On
To enable your spot color matches for use with the CX3641MFP, save your edits before
you exit Spot-On. This ensures that all your changes to Spot-On color definitions are
stored on the CX3641MFP and available for use when printing documents that contain
spot colors.

The following edits do not require saving to take effect:
• Rearranging the priority level of a color group
• Downloading a color group
• Clearing or deleting a color group

TO SAVE THE SPOT-ON COLOR LIST
1 Choose Save from the File menu.
2 Click Close in the upper-right corner of the Spot-On main window to exit the utility.
Spot-On with Substitute Colors

The Substitute Colors workflow involves defining the substitute color values with Spot-On, and then printing a document with the Substitute Colors print option set to On from the printer driver. You can also override the print option setting using Command WorkStation.

**NOTE:** Color substitutions affect only text, vector, and line art. They have no effect on raster images.

**NOTE:** When a color is defined as a substitute color, the settings for an RGB color (such as RGB Source, Rendering Style, and RGB Separation) or CMYK color (such as CMYK Simulation Profile and CMYK Simulation Method) have no effect. The color is converted with a process similar to spot color conversion.

Creating a color for substitution

Use the following procedure to add a new substitute color in a substitute group and specify the value-name for a color to substitute.

**NOTE:** A new substitute color can be added only to a substitute group.

---

**TO ADD A NEW SUBSTITUTE COLOR AND SPECIFY THE VALUE-NAME FOR SUBSTITUTION**

1. **Start ColorWise Pro Tools and connect to the CX3641MFP.**

   Start ColorWise Pro Tools from a stand-alone application or Command WorkStation, at your computer or at the monitor connected to the CX3641MFP.

2. **Click Spot-On.**

   The Select Output Profile dialog box appears.
3 Select an output profile and click OK.

The Spot-On main window appears.

4 Select the location in the group list where you want the addition to be placed.

5 Choose New Substitute Group from the Edit menu.

A new substitute group entry appears as Untitled.

6 Double-click Untitled and type a new name.

7 Select the substitute group and choose New Substitute Color from the Edit menu.

   NOTE: If the substitute group already contains substitute colors, select the color above the location where you want to add a new substitute color.

The Add Substitute Color dialog box appears.

8 Select a color mode for the substitute color.

9 Select a tolerance degree for the substitute color.

For information about Tolerance, see page 78.
SPOT-ON

10 Type the values for the color that you want to substitute.

11 Click OK.

The substitute color appears at the specified location.

**Defining the color values for a substitute color**

After you specify the original color to substitute, define CMYK values for the substitute color by typing the exact CMYK values in the Spot-On main window or Set Center Patch Color dialog box, or use Spot-On Color Search.

For instructions on defining a substitute color by typing the exact CMYK values, see the following sections. To define a substitute color in the Spot-On Color Search dialog box, see page 76.

---

**TO DEFINE A SUBSTITUTE COLOR IN THE SPOT-ON MAIN WINDOW**

1 Start ColorWise Pro Tools and connect to the CX3641MFP.

2 Click Spot-On.

The Select Output Profile dialog box appears.

3 Select an output profile and click OK.

The Spot-On main dialog box appears.

4 Select the color that you want to substitute.

5 Double-click the value under C, M, Y, and K, and type a new number for each color channel.

The new values for the substitute color appear in the color list.

**NOTE:** The edited color is not saved until you choose Save from the File menu.
TO DEFINE A SUBSTITUTE COLOR IN SET CENTER PATCH COLOR

1 Select the color that you want to substitute.

2 Double-click the color icon.

   The Spot-On Color Search dialog box appears with the selected color in the center.

3 Click the center patch.

   The Set Center Patch Color dialog box appears.

4 Type values for each C, M, Y, and K color channel.

   For information about using Set Center Patch Color, see page 66.

5 Click OK.

   The new color appears in the center in the Spot-On Color Search dialog box.

6 Click OK.

   The new color appears in the color list of the Spot-On main window.

NOTE: The edited color is not saved until you choose Save from the File menu.

Use the following procedure to target a substitute color using the Spot-On Color Search dialog box.
TO DEFINE A SUBSTITUTE COLOR USING SPOT-ON COLOR SEARCH

1 Select the color that you want to substitute.

2 Double-click the color icon.

   The Spot-On Color Search dialog box appears, displaying the current color in the center.

3 Click neighboring patches until you find the color that you want to use for the substitution.

   For information about using Spot-On Color Search, see page 68.

4 Click OK.

   The new substitute color appears in the color list of the Spot-On main window.

   NOTE: The edited color is not saved until you choose Save from the File menu.

Printing a job with a substitute color

After you define CMYK values for substitution in Spot-On, you can print a document and specify in the printer driver that the substitute color be used. You can also specify this print option for an existing print job by overriding the job’s properties in Command WorkStation.

   NOTE: When you print the job, select an Output Profile setting from the printer driver that matches the output profile you selected in Spot-On to define the color substitution. Otherwise, the color substitutions that are defined on Spot-On have no effect.

   NOTE: The procedures for printing a job from a Mac OS and a Windows computer are similar. The following procedure shows the Mac OS version.

TO PRINT A JOB WITH A SUBSTITUTE COLOR

1 Open a document in your application.

2 Choose Print.
3 Click Copies & Pages and choose ColorWise from the menu.

The ColorWise pane appears.

New

screenshot

TBD

4 Select Substitute Colors.

5 Click Print.

The job is printed with the substitute you defined in Spot-On.

Substitute Color dialog box

You can define the color mode and tolerance range for a substitute color in the Add Substitute Color or Rename Substitute Color dialog box.

![Add Substitute Color dialog box](image)

**NOTE:** The Add Substitute Color dialog box appears when you choose Edit> New Substitute Color after selecting a substitute color group in the list. The Rename Substitute Color dialog box appears when you double-click the bracketed section of a substitute color.

**NOTE:** The Add Substitute Color and Rename Substitute Color dialog boxes offer the same control in defining a substitute color.

- **Substitute Color:** Select the following color modes for a substitute color:
  - CMYK (0-100%)
  - RGB (Device Code 0-255)
  - RGB (0-100%)
**Tolerance**: Select the following tolerance ranges for a substitute color:

- Small (indicated in lowercase)
- Large (indicated in uppercase)

To avoid entry errors, the Add Substitute Color and Edit Substitute Color dialog boxes display the values in the following predefined formats. The dialog boxes also display uppercase or lowercase characters and a “%” symbol, depending on the selections.

- **CMYK (0-100%) mode**
  - Small: <“0”%c, “0”%m, “0”%y, “0”%k>
  - Large: <“0”%C, “0”%M, “0”%Y, “0”%K>

- **RGB (Device Code 0-255) mode**
  - Small: <“0”r, “0”g, “0”b>
  - Large: <“0”R, “0”G, “0”B>

- **RGB (0-100%) mode**
  - Small: <“0”%r, “0”%g, “0”%b>
  - Large: <“0”%R, “0”%G, “0”%B>

---

**Principles for Substitute Colors**

In setting the values for Substitute Colors, keep in mind the following principles.

**Tolerance range**

The accuracy of the substitute color is affected by various elements, such as applications, operating systems, printer drivers, and distilling processes. To accommodate the “errors” that occur because of the rounding rules between the numbers entered by users and the numbers received by the CX3641MFP, the options of the small and large tolerance ranges are provided for color substitution.

The following table provides Small and Large substitution tolerance ranges for each color mode.

<table>
<thead>
<tr>
<th>Color mode</th>
<th>Small tolerance range</th>
<th>Large tolerance range</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMYK (0-100%)</td>
<td>+/- 0.25%</td>
<td>+/- 0.5%</td>
</tr>
<tr>
<td>RGB (Device Code 0-255)</td>
<td>+/- 0.25</td>
<td>+/- 1</td>
</tr>
<tr>
<td>RGB (0-100%)</td>
<td>+/- 0.25%</td>
<td>+/- 0.5%</td>
</tr>
</tbody>
</table>

**NOTE**: Values for tolerance ranges are approximate.
• **CMYK (0-100%)**
  - Small: A substitute color replaces any color that falls within the nearest +/- 0.25% of the color value entered.
  - Large: A substitute color replaces any color that falls within the nearest +/- 0.5% of the color value entered.

• **RGB (Device Code 0-255)**
  - Small: A substitute color replaces any color that falls within the nearest +/- 0.25 of the color value entered.
  - Large: A substitute color replaces any color that falls within the nearest +/- 1 of the color value entered.

• **RGB (0-100%)**
  - Small: A substitute color replaces any color that falls within the nearest +/-0.25% of the color value after scaling.
  - Large: A substitute color replaces any color that falls within the nearest +/-0.5% of the color value after scaling.

**Color substitution**

A color substitution takes place when a substitute color is defined with a different set of CMYK values for the same value-name as the original color.

The following color examples show how a substitution works.

• **Original color**: <100, 0, 0, 0> for the CMYK values (cyan)
• **Substitute 1**: <0, 100, 100, 0> (red)
• **Substitute 2**: <100, 0, 100, 0> (green)

**NOTE:** In the examples, the extreme values and terms “red” and “green” are used for illustrative purposes only. In practice, color substitution is not used for extreme color shifts.

The following table shows color substitution with different sets of CMYK values assigned to the same original color.

<table>
<thead>
<tr>
<th>Substitution value-name</th>
<th>CMYK values</th>
<th>Before substitution</th>
<th>After substitution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original color</td>
<td>—</td>
<td>&lt;100, 0, 0, 0&gt;</td>
<td>—</td>
</tr>
<tr>
<td>Substitute 1</td>
<td>&lt;100.0c, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td>cyan</td>
</tr>
<tr>
<td>Substitute 2</td>
<td>&lt;100.0c, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td>cyan</td>
</tr>
</tbody>
</table>
**Priority scheme**

If two substitute colors are defined with the same value-names, but with different sets of CMYK values and different tolerance ranges, Spot-On resolves the priority of substitution according to the order of color in the group.

Spot-On process color substitution is based on the order of color in the group. The color entries at the top of the list have priority over the colors at the bottom of the list. Spot-On scans the list from top to bottom and processes substitution in linear order. When a color is remapped, it is not overridden by any subsequent substitution call.

The following color examples show how the priority scheme works.

- **Original color**: <100, 0, 0, 0> for the CMYK values (cyan)
- **Substitute 3**: <0, 100, 100, 0> (red) with a small tolerance
- **Substitute 4**: <100, 0, 100, 0> (green) with a large tolerance

**NOTE:** In the examples, the extreme values and terms “red” and “green” are used for illustrative purposes only.

**Order of the colors**

- **Case 1**: Substitute 3 (red) is higher than Substitute 4 (green) in the list.
- **Case 2**: Substitute 4 (green) is higher than Substitute 3 (red) in the list.

The following table shows the scheme of priority when the same value-names are assigned to the original color with different sets of CMYK values and different tolerance ranges.

<table>
<thead>
<tr>
<th>Color order</th>
<th>Substitution value-name</th>
<th>CMYK values</th>
<th>Before substitution</th>
<th>After substitution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original color</td>
<td>&lt;100, 0, 0, 0&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case 1 Substitute 3</td>
<td>&lt;100.0c, 0.0m, 0.0y, 0.0k&gt;</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td>cyan</td>
<td>red</td>
</tr>
<tr>
<td></td>
<td>&lt;100.0C, 0.0M, 0.0Y, 0.0K&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td></td>
<td>(see the following)</td>
</tr>
<tr>
<td>Case 2 Substitute 4</td>
<td>&lt;100.0C, 0.0M, 0.0Y, 0.0K&gt;</td>
<td>&lt;100, 0, 100, 0&gt;</td>
<td>cyan</td>
<td>green</td>
</tr>
<tr>
<td>Substitute 3</td>
<td>&lt;0, 100, 100, 0&gt;</td>
<td></td>
<td></td>
<td>(see the following)</td>
</tr>
</tbody>
</table>

Substitute 3 and Substitute 4 have the same value-names, but depending on their order in the list, Spot-On produces different results.

- In Case 1, Substitute 3, red, is given higher priority because it is higher in the list. All occurrences of the original color, cyan, within the Small tolerance range are substituted with red. Occurrences of cyan within the Large tolerance range but not within the Small tolerance range are substituted with Substitute 4, green.
In Case 2, Substitute 4, green, is given higher priority because it is higher in the list. Substitute 3, red, can only substitute for occurrences of the original color, cyan, within the Small tolerance range, and those occurrences have already been substituted with green. Therefore, no substitution with red takes place.

**Uploading and downloading a substitute color group**

Like named color groups, you can upload or download a substitute color group as an ICC profile. The substitute color definitions are saved with private tags as part of an ICC profile, allowing you to export the Substitution Group definitions between multiple print servers.
COLORWISE PRINT OPTIONS

The ColorWise color management system provides print options that affect the output of objects in various color spaces. By specifying the appropriate settings for each print option, you can obtain the expected results for your jobs.

About this chapter

This chapter provides an overview of the ColorWise management system, which controls color on the CX3641MFP (see page 83), and detailed explanations of each print option. For the location of each print option, see the following table.

<table>
<thead>
<tr>
<th>ColorWise print option</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Trapping</td>
<td>page 84</td>
</tr>
<tr>
<td>Black Detection</td>
<td>page 84</td>
</tr>
<tr>
<td>Black Overprint</td>
<td>page 85</td>
</tr>
<tr>
<td>Black Text/Graphics</td>
<td>page 86</td>
</tr>
<tr>
<td>CMYK Simulation Profile</td>
<td>page 87</td>
</tr>
<tr>
<td>CMYK Simulation Method</td>
<td>page 88</td>
</tr>
<tr>
<td>Combine Separations</td>
<td>page 89</td>
</tr>
<tr>
<td>Composite Overprint</td>
<td>page 90</td>
</tr>
<tr>
<td>Output Profile</td>
<td>page 91</td>
</tr>
<tr>
<td>Print Gray using Black Only</td>
<td>page 91</td>
</tr>
<tr>
<td>Rendering Styles</td>
<td>page 92</td>
</tr>
<tr>
<td>RGB Separation</td>
<td>page 92</td>
</tr>
<tr>
<td>RGB Source Profile</td>
<td>page 93</td>
</tr>
<tr>
<td>Spot Color Matching</td>
<td>page 94</td>
</tr>
<tr>
<td>Substitute Colors</td>
<td>page 95</td>
</tr>
</tbody>
</table>

This chapter also provides information about PostScript printer drivers and instructions for setting the ColorWise print options for Windows and Mac OS computers. For information about printer drivers, see page 96.
Managing color on the CX3641MFP

To modify CX3641MFP printing behavior, do any of the following:

- Specify ColorWise options for an individual print job using the menus that appear in the printer driver.

- Specify most ColorWise options as server defaults from Color Setup in ColorWise Pro Tools (see page 30). You can also set default values from CX3641MFP Setup, as described in Configuration and Setup. The defaults apply to all subsequent print jobs unless you override them.

- Specify ColorWise options, particularly default ICC profile settings and calibration options, from ColorWise Pro Tools. These options include default Simulation Profile (see page 87), Simulation Method (see page 88), default Source Profile (see page 93), RGB Separation (see page 92), and associated calibration set (see page 34).

Applications allow you to generate color data for the CX3641MFP in many different color spaces. The most common type of color data produced from office applications is RGB, while prepress applications generally produce CMYK data. Desktop applications also generate spot colors, such as PANTONE colors. To complicate matters, a single page may contain a mix of RGB, CMYK, and spot colors. The CX3641MFP allows you to control the printing of mixed-color documents with features that apply specifically to RGB, CMYK, or spot color data.

The following diagram illustrates the print options in the CX3641MFP color management process that affect color data conversions. You can access these print options when you send a print job to the CX3641MFP. Most of these options and settings are described in subsequent sections of this chapter.

RGB Source Profile is the only color option that applies strictly to RGB color data. The other options that affect RGB color also affect the more rarely used Lab, XYZ, and other calibrated color spaces.
NOTE: With PostScript 3, a PostScript job can include calibrated CMYK (or CIEBasedDEFG) data. The Rendering Style print option, which normally affects only RGB data, affects calibrated CMYK data as well. The RGB Source Profile setting does not affect calibrated CMYK data.

**ColorWise print options**

The following sections provide detailed explanations of the ColorWise print options and how these options affect print jobs.

**Auto Trapping**

Trapping is a technique where the size of objects is modified so that colors printed next to each other overlap slightly, to prevent white spaces between two colors. These white spaces, or “halos,” can be caused by factors such as misregistration, the physical properties of the toners, and the stiffness of the media. This illustration shows the same image with and without trapping.

If you enable the Auto Trapping option, trapping is applied to all the objects in a job.

**Black Detection**

The Black Detection option allows you to specify whether or not to detect black-and-white pages before printing your job. To use this option, set Color Mode to Standard Color or Expert Color.

- **Off**: Select Off if your job consists of black-only text pages combined with a significant number of color pages.
- **On**: Select On if you are printing a predominantly black-and-white job. Black-and-white only pages will print with the proper billing information.
Black Overprint

The Black Overprint option allows you to specify whether or not black text or black text and graphics, defined as RGB=0, 0, 0, or as CMYK=0%, 0%, 0%, 100%, overprints colored backgrounds.

- **Text**: Black text overprints colored backgrounds, eliminating white gaps and reducing the halo effect or misregistration of colors. You can choose this setting only if the Black Text/Graphics option is set to Pure Black On.

- **Text & Graphics**: Black text and graphics overprint colored backgrounds, eliminating white gaps and reducing halo effects or misregistration of colors. You can choose this setting only if the Black Text/Graphics option is set to Pure Black On.

- **Off**: Black text or text/graphics knocks out colored backgrounds.

**NOTE**: Before sending the print job to the copier/printer, PostScript applications may perform their own black overprint conversions.

One example of how you might use this setting is a page that contains black text on a light blue background. The background blue is CMYK=40%, 30%, 0%, 0%. The black text is CMYK=0%, 0%, 0%, 100%.

- With Black Overprint set to Text or Text & Graphics, the final text or text/graphic portions of the page are overprinted, or combined with the underlying color. Black colors generated by applications (for example, RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) are printed using the black toner. This means that black text and line art does not exhibit halftone artifacts (as long as the copier/printer is calibrated correctly). No transition in cyan and magenta toners occurs. The quality of the output is improved, because it does not show artifacts near the edges of the text defined in the RGB color space (RGB=0, 0, 0).

- With Black Overprint Off, the border of the text or text/graphics is on an edge that has cyan and magenta toners on one side (outside the text) and black toner on the other side (inside the text). This transition may cause visible artifacts due to the practical limitations of the copier/printer.

**NOTE**: Setting Black Overprint to Text/Graphics allows black text or graphics to overprint color backgrounds (see “CMYK Simulation Method” on page 88).

**NOTE**: The reproduction of CMYK components is affected by the CMYK Simulation setting and calibration curve when CMYK is not 0%, 0%, 0%, 0%.
Black Text/Graphics

The Black Text/Graphics option affects black text and vector graphics. Under most circumstances, set this option to Pure Black On. When Black Text/Graphics is set to Pure Black On, black colors generated by applications (for example, RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) are printed using black toner only. The black text and line art do not exhibit halftone artifacts (as long as the copier/printer is calibrated correctly) and are not misregistered, since one toner is used. In addition, this setting eliminates blasting. This option must be set to Pure Black On if you want to set the Black Overprint option to Text or Text/Graphics.

For some jobs, it is preferable to clear this option, for example, if the page includes gradient fills that use black. The following table describes the behavior of the Black Text/Graphics option with black data defined in different color spaces.

**NOTE:** Use the Black Text/Graphics option only when printing composites, not when printing separations.

<table>
<thead>
<tr>
<th>Color</th>
<th>Black Text/Graphics = Normal</th>
<th>Black Text/Graphics = Pure Black On or Rich Black On</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB=0,0,0 (all other RGB values are unaffected by the Black Text/Graphics setting)</td>
<td>RGB=0,0,0 is printed according to the definition for RGB=0,0,0 in the output profile. This may be a rich black using all toners if the output profile specifies a rich black, or may be K-only if the output profile specifies K-only for RGB=0,0,0. The output is affected by the calibration curve.</td>
<td>RGB=0,0,0 is printed as K-only, using the black toner (Pure Black On) or 100% K plus 50% Cyan (Rich Black On) using black and cyan toners. All other RGB values are unaffected by the Black Text/Graphics setting.</td>
</tr>
</tbody>
</table>
NOTE: PostScript applications, such as QuarkXPress, may convert elements defined as RGB=0, 0, 0 to four-color CMYK black before sending the job to the CX3641MFP. These elements are not affected by the Black Text/Graphics option. For more information, see *Fiery Color Reference*. Also, black text and line art defined as RGB=0, 0, 0 in office applications, such as Microsoft Word, are converted to single-color black (CMYK=0%, 0%, 0%, 100%) by the Microsoft PostScript 3 printer driver for Windows 2000/XP/Server 2003. To print this single-color black at the maximum toner density of the copier/printer, set Black Text/Graphics to Pure Black On.

### CMYK Simulation Profile

The CMYK Simulation Profile print option allows you to print press proofs or simulations. This setting specifies the offset press standard or other color printing device that you want to simulate. This option affects CMYK data only.

**NOTE:** If a document contains an embedded CMYK profile, the embedded profile is applied to CMYK data and the CMYK Simulation Profile option is ignored.

With Windows printer drivers, you can also view an unlimited number of custom Full simulations created using ColorWise Pro Tools. On Mac OS computers, you can view up to 10 Full custom simulations. The number of custom simulations is limited by the available disk space on the CX3641MFP.
If you are printing with the PostScript driver and have Two-Way Communication enabled, the name of each downloaded or custom profile appears in the CMYK Simulation Profile menu. If Two-Way Communication is not enabled, downloaded or custom profiles appear as Simulation-1 through Simulation-10. For more information about Two-Way Communication, see *Printing from Windows* or *Printing from Mac OS*.

The None setting sends your original CMYK data to the copier/printer in its calibrated state, without conversions to simulate another printer. The ColorWise Off setting sends your original CMYK data to the copier/printer in an uncalibrated state, without conversions to simulate another printer.

The CMYK Simulation Profile setting you specify depends on the press standard for which the CMYK data was separated.

- For images that were separated using a custom separation (such as a separation produced with an ICC profile), choose the corresponding profile on the CX3641MFP with the CMYK Simulation Profile setting.
- For images that were separated for SWOP, choose SWOP as the CMYK Simulation Profile setting.

To properly simulate a printed image that was separated using an ICC profile, the same profile must be present on the CX3641MFP. For more information about downloading ICC profiles to the CX3641MFP, see page 11.

**CMYK Simulation Method**

The CMYK Simulation Method allows you to define your preferred CMYK-to-CMYK conversion technique.

- **Quick** applies one-dimensional transfer curves to adjust output densities in the cyan, magenta, yellow, and black channels. This technique leads to eye-pleasing color output from your copier/printer because pure primary colors are not “contaminated” by other colorants. While it is the fastest simulation method and perfect for drafts, avoid using it for final documents that are used as press proofs. Other techniques offer the color simulation accuracy required by proofing applications.

- **Full (Source GCR)** provides a complete and accurate simulation based on colorimetric transformations. Hues are preserved, even for primary colors. The Gray Component Replacement (GCR) level that was specified in the original (source) document is also preserved for K-only text and graphics. Processed black expressed in CMY is reproduced using CMY toner. Full (Source GCR) is recommended for the highest quality press proofing applications.
- **Full (Output GCR)** is a complete and accurate simulation method based on colorimetric transformations. Hues are preserved, even for primary colors. With this method, the Gray Component Replacement (GCR) level that was specified in the original document is not preserved. Instead, all CMYK data is reseparated using the GCR level specified by the output profile. This simulation technique is similar to traditional ICC color matching methods and is more appropriate than Full (Source GCR) for full color printing designed for the press, but reproduced on your copier/printer.

**NOTE:** When you specify Pure Black On for Black Text/Graphics and Full (Output GCR) for CMYK Simulation Method, the black text and graphics in your document are printed with 100% black-only toner.

**Combine Separations**

The Combine Separations setting specifies how to print separated CMYK data. It supports: Cyan, Magenta, Yellow, Black, and one or more spot colors.

- **Off** prints each separation individually.
- **On** combines separations as a single, composite-color document, and automatically makes the settings for the following print options: Color Mode (CMYK), Black Text/Graphics (Normal), Black Overprint (Off), and Spot Color Matching (Off).

The results of combining the multiple plates are predictable and accurate, regardless of the original application used. This feature also fully supports DCS 2.0 file formats when included in a PostScript print job from a page layout application.
The following applications have been tested with Mac OS and Windows for compatibility with the Combine Separations option:

- Adobe Illustrator
- Adobe InDesign
- Adobe PageMaker
- Macromedia FreeHand
- QuarkXPress

For information about using the Combine Separations option with applications such as Photoshop, see *Fiery Color Reference*.

**Composite Overprint**

When overlapping objects are printed, the foreground object can either overprint or knock out the background object. With overprinting, the color of the background object shows through the foreground object where they overlap, and the resulting color is a combination of the colors of the two objects. With a knock-out, the foreground object hides the background object where they overlap.

The Composite Overprint print option allows you to print overprinted objects as specified in the source file. By default, the Composite Overprint print option is off and overlapping objects print as knockouts.

The Composite Overprint print option is supported for PostScript and PDF jobs produced by the following applications:

- Adobe Acrobat
- Adobe Illustrator
- Adobe InDesign
- Macromedia FreeHand
- QuarkXPress
- CorelDRAW

If Composite Overprint is enabled for a job that contains spot colors, Spot-On must be enabled on the CX3641MFP.

A job with more than 32 spot colors may not print as expected.
Output Profile

Because the output profile is applied to all data in the print job, make sure the profile you select is the right one for your job. The default output profile consists of a profile for your copier/printer that describes its color characteristics and a calibration target that describes the expected behavior of the copier/printer.

Use the ColorWise Pro Tools Profile Manager to download your own output profile to the CX3641MFP (see “Using Profile Manager” on page 25). Downloaded output profiles are at first associated with the calibration target that is tied to the default output profile. You can edit calibration target D-Max values separately.

If you are printing with the PostScript driver and have enabled Two-Way Communication, the name of each downloaded or custom profile appears in the Output Profile menu. If Two-Way Communication is not enabled, downloaded or custom profiles appear as Output-1 through Output-10. For more information about Two-Way Communication, see Printing from Windows or Printing from Mac OS.

Select the Use Media Defined Profile setting to automatically apply the output profile associated with the media type used in a print job rather than setting a specific output profile. For more information, see “Using media-defined output profiles” on page 26.

Select the Use Server’s Default setting to use the default Output Profile set in Color Setup. For more information about Color Setup, see “Using Color Setup” on page 30.

Print Gray using Black Only

When Print Gray using Black Only is enabled, any gray (any color where R=G=B or C=Y=M, or any K-only color) in a job is printed using only black toner instead of processed black.

You can choose to apply the Print Gray using Black Only option to either Text and Graphics or to Text, Graphics, and Images.

The following limitations apply:

- The Print Gray using Black Only option has no effect on a job that is pre-separated, except that if Print Gray using Black Only (CMYK) is off, each separation, which is a grayscale image, is printed in a 4-color gray.
- If CMYK Simulation Method is set to Full (Source GCR) or Quick, the Print Gray using Black Only (CMYK) setting does not affect the output.
- If RGB Separation is set to Simulation, the Print Gray using Black Only (RGB) option is disabled. Likewise, if the Print Gray using Black Only (RGB) option is enabled, you cannot set RGB Separation to Simulation.
- If Black Text/Graphics is set to Pure Black On or Rich Black On, it takes precedence over Print Gray using Black Only for 100% black text and graphics.
• If a gray is specified as a spot color, the Print Gray using Black Only option does not affect that gray.

**Rendering Styles**

The Rendering Style option specifies a CRD for color conversions. To control the appearance of images, such as prints from office applications or RGB photographs from Photoshop, select the appropriate rendering style. The CX3641MFP allows you to choose from the four rendering styles currently found in industry standard ICC profiles.

<table>
<thead>
<tr>
<th>CX3641MFP rendering style</th>
<th>Best used for</th>
<th>Equivalent ICC rendering style</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Photographic:</strong> Typically results in less saturated output than presentation rendering when printing out-of-gamut colors. This style preserves tonal relationships in images.</td>
<td>Photographs, including scans and images from stock photography, CDs and digital camera images.</td>
<td><strong>Image, Contrast, and Perceptual</strong></td>
</tr>
<tr>
<td><strong>Presentation:</strong> Creates saturated colors but does not match printed colors precisely to displayed colors. In-gamut colors, such as flesh tones, are rendered well. This style is similar to the Photographic rendering style.</td>
<td>Artwork and graphs in presentations. In many cases, this style can be used for mixed pages that contain presentation graphics and photographs.</td>
<td><strong>Saturation, Graphics</strong></td>
</tr>
<tr>
<td><strong>Relative Colorimetric:</strong> Provides white-point transformation between the source and destination white points. For example, the bluish white color (gray) of a monitor is replaced by paper white. This style avoids visible borders between blank spaces and white objects.</td>
<td>Advanced use when color matching is important, but you prefer white colors in the document to print as paper white. This style may also be used with PostScript color management to affect CMYK data for simulation purposes.</td>
<td><strong>Relative Colorimetric</strong></td>
</tr>
<tr>
<td><strong>Absolute Colorimetric:</strong> Provides no white point transformation between the source and destination white points. For example, the bluish white color (gray) is not replaced by paper white.</td>
<td>Situations when exact colors are needed and visible borders are not distracting. This style may also be used with PostScript color management to affect CMYK data for simulation purposes.</td>
<td><strong>Absolute Colorimetric</strong></td>
</tr>
</tbody>
</table>

**RGB Separation**

The RGB Separation option determines how RGB colors (as well as Lab and XYZ colors) are converted to CMYK. The name of this option is meant to be descriptive, because the option defines the color spaces that are used by the CX3641MFP to “separate” the RGB data into CMYK values.
The two choices available for this option determine whether RGB data is converted into the full gamut of the copier/printer (output) or is first converted into the gamut of another digital printer or press standard (simulation). This feature helps make one device behave like another for RGB data. For example, if a high-quality ICC profile is available for another print device, the copier/printer can simulate the behavior of that device.

RGB Separation is also useful for prepress applications. For example, it allows you to experiment with the appearance of an RGB scan under different press printing conditions, without having to convert the RGB data to CMYK data for each condition. When the desired printing condition is found, convert the file to CMYK, using the same CMYK simulation profile that you used during the experimentation.

**NOTE:** Use the RGB Separation print option in conjunction with the Output Profile or CMYK Simulation Profile print options.

- **Output** converts all RGB colors into the CMYK color space of your copier/printer (when set to the printer’s default), or a customized CMYK color space for your copier/printer (when set to Output 1-10).
- **Simulation** converts all RGB colors into the CMYK color space for a specified simulation (select the desired simulation with the CMYK Simulation Profile print option).

**RGB Source Profile**

The RGB **source profile** setting allows you to define the characteristics of the RGB data in your document so that the appropriate color conversion occurs on the CX3641MFP. Commonly used monitor color spaces are available from the printer driver and the CX3641MFP. For others, use ColorWise Pro Tools Profile Manager to download custom monitor or scanner profiles.

When you specify a setting other than None for the RGB Source Profile, the CX3641MFP overrides **source color space** definitions or profiles that other color management systems may have specified. For example, if your document contains an embedded RGB profile, the RGB Source Profile setting overrides it. In cases where you do not want this setting to override another specified source color space, choose None.

When you specify a setting other than None, because the color space definitions are overridden, the output from the CX3641MFP is consistent across platforms. The CX3641MFP RGB Source Profile options are as follows:

- **EFIRGB** specifies an EFI-defined color space recommended for users who have no detailed information about their RGB data.
- **sRGB (PC)** specifies the definition of a Windows computer monitor profile used as the default.
- **Apple Standard** specifies the definition of a Mac OS computer monitor profile used as the default.
• **Adobe RGB (1998)** is an Adobe-defined color space, used in pre-press as the default working space in Photoshop 5.

• **ECI-RGB** is the European Color Initiative (ECI) recommended space for use as an RGB working color space and color data exchange format for ad agencies, publishers, reproduction and printing houses.

• **Fiery RGB** is an EFI-defined color space recommended for users of office applications. This color space is similar to EFIRGB but is larger and can provide a more desirable blue output.

• **Sources 1-10** specify the definitions you download as RGB source profiles.

  If you are printing with the PostScript driver and have enabled Two-Way Communication, the name of each downloaded profile appears in the RGB Source Profile setting menu. If Two-Way Communication is not enabled, downloaded profiles appear as Source-1 through Source-10. For more information about Two-Way Communication, see *Printing from Windows* or *Printing from Mac OS*.

• **None** instructs the CX3641MFP to allow the RGB sources you defined elsewhere, such as in the application, to be used. When you set RGB Source to None, the appearance of colors is not independent of the file type. For example, RGB EPS files looks different from RGB TIFF files.

  With RGB Source set to None, PostScript RGB data that contains a source color space definition is converted using the CRD specified by the Rendering Style option (see “Rendering Styles” on page 92). Non-PostScript RGB data and PostScript RGB data that does not contain a source color space definition are converted using a general **undercolor removal (UCR)** conversion method.

**Spot Color Matching**

The Spot Color Matching option provides automatic matching of spot colors with their best CMYK equivalents.

• **On**: The CX3641MFP uses a built-in table to generate the closest CMYK matches of spot colors your copier/printer can produce. (New tables are generated when you add new output profiles.)

  With Spot-On, the CX3641MFP uses the CMYK matches determined through Spot-On (see page 59).

• **Off**: The CX3641MFP processes the spot color as CMYK data and uses CMYK equivalents defined by the spot color manufacturer, such as PANTONE. These are the same CMYK equivalents used by applications that include spot color libraries.

**NOTE**: Spot colors that are not included in the built-in table are treated as CMYK.
For jobs that include spot colors, set Spot Color Matching to On unless you are printing press simulations. In that case, set Spot Color Matching to Off and choose the appropriate CMYK Simulation setting (see page 87).

For a PDF job that includes spot colors that are not included in the built-in table, setting Spot Color Matching to On retains the original spot colors. The CX3641MFP references the built-in table to generate the closest CMYK matches of the original spot color.

**NOTE:** Use Spot Color Matching only when printing composites, not when printing separations.

**Spot Color Matching and the PANTONE Coated Color Reference**

The PANTONE Coated Color Reference prints differently depending on the Spot Color Matching setting (see *Fiery Color Reference*).

- **On:** The CX3641MFP uses a built-in table or, with Spot-On, the Spot-On color dictionaries to generate the best matches for the PANTONE colors that your copier/printer can produce. The PANTONE number is displayed below each swatch.

  For more information about Spot-On, see page 59.

- **Off:** The CX3641MFP prints swatches using the CMYK values recommended by Pantone, Inc. (and used by applications that provide PANTONE color libraries). The CMYK values used to generate the color, as well as the PANTONE number of the color, are printed below each swatch. These CMYK values are printed through the selected CMYK Simulation and Output Profile settings.

**Substitute Colors**

Spot-On allows you to create a list of substitute colors. These are colors that, when called for in a document by their RGB or CMYK values, are substituted with a different color having the CMYK values from the Spot-On color dictionary. This permits exact color control and overrides individual RGB and CMYK colors.

To enable substitute colors for a job, select the Substitute Colors option.

For more information about creating and using substitute colors, see “Spot-On with Substitute Colors” on page 72.
Printer drivers and print options

The printer driver writes a PostScript file containing the instructions generated by your application and the settings for the ColorWise print options you selected. The printer driver then sends the PostScript file to the CX3641MFP. The CX3641MFP performs PostScript processing and color conversions and sends raster color data to the copier/printer.

Setting print options for Windows

This section explains how to set color management print options with the Adobe and Microsoft PostScript printer drivers for Windows, PostScript 3 printer drivers that take full advantage of the color features of the CX3641MFP.

Before you proceed, do the following:

• Install the printer driver and the CX3641MFP PPD (see Printing from Windows).
• Set up the CX3641MFP for printing (see Printing from Windows).

NOTE: The following illustrations and instructions do not apply to all applications. Many applications, such as Adobe PageMaker, Photoshop, Adobe Illustrator, QuarkXPress, and CorelDRAW, have other color management options in addition to those presented in the printer driver. For information about specific applications, see Fiery Color Reference.

Use the following procedure to set the color options for Windows computers.

TO SET PRINT OPTIONS FOR WINDOWS COMPUTERS

1 Choose Print in your application.

2 Select CX3641MFP as your printer and click Properties.

   In the Properties dialog box, the Fiery Printing tab is displayed.

3 Click the ColorWise icon.

New screenshot

TBD

4 Specify the settings for the print options in the Color window.

For information about ColorWise print options, see page 84.
5 Click Expert Settings.

The Expert Color Settings dialog box appears.

New

screenshot

TBD

This dialog box displays most of the ColorWise print options for the CX3641MFP.

6 Click Update to display the current CX3641MFP settings.

If the Update button does not appear, make sure that Two-Way Communication is set up. For information about enabling Two-Way Communication, see Printing from Windows.

7 Specify the settings for the main ColorWise print options.

For most users, the default settings provide adequate color control. For information about individual print options, see page 84.

8 Click OK to exit Expert Color Settings.

9 Click OK to close the Properties window, and then click OK to send your job.

Setting color management print options for Mac OS

This section explains how to set color management print options with the printer drivers for Mac OS.

Before you proceed, do the following:

- Install the CX3641MFP PPD (see Printing from Mac OS).
- Set up the CX3641MFP for printing (see Printing from Mac OS).
TO SET PRINT OPTIONS FOR MAC OS X COMPUTERS

1 Choose Print in your application.

The Print dialog box appears.

2 Choose ColorSync from the drop-down list.

The ColorSync pane appears.

3 Choose In Printer from the Color Conversion menu.

4 Choose ColorWise from the drop-down list.

The ColorWise pane appears.

New screenshot
TBD

5 Select Two-Way Communication.

For information about enabling Two Way Communication, see Printing from Mac OS.
6 Specify the settings for the print options in the ColorWise pane.
   For information about ColorWise print options, see page 84.

7 Click Expert Settings in the Print Mode pane.
   The ColorWise Expert Settings dialog box appears.

New

screenshot

TBD

8 Choose settings for the main ColorWise print options.
   For information about ColorWise print options, see page 84.

9 Click OK.
   The ColorWise pane reappears.

10 Click Print.

Using Expert Color Settings to enable Device Link Profiles

When you print a job, you can enable Device Link Profiles by using the CX3641MFP printer driver if you have Two-Way Communication enabled. When you enable a Device Link Profile, you will be able to see the Device Link Profile in use in Expert Color.

NOTE: If you do not have Two-Way Communication enabled, and you select an RGB Source Profile and Output Profile that corresponds to a Device Link Profile, the Device Link Profile will be activated, although you will not see the Device Link Profile in use in Expert Color.

For information about installing and assigning Device Link Profiles, see page 26.

NOTE: The procedures for enabling Device Link Profiles using Expert Color Settings for Windows and Mac OS X are similar. The following illustrations use Windows screens. Any differences are noted.
To use the CX3641MFP printer driver to enable Device link profiles

1 Enable Two-Way Communication.
   For more information about enabling Two-Way Communication, see Printing from Windows or Printing from Mac OS.

2 From your application, select Print.

3 Select CX3641MFP as your printer and click Properties.

4 Click the Color icon.

5 Click Expert Settings.

6 Select the Source Profile and the Output Profile.
   When you select a Source Profile and Output Profile combination that is defined in a Device Link Profile, the Device Link Profile is automatically enabled.
   When the Device Link Profile is selected, the Color Process workflow updates and some options may not appear. You will see the message “Device Link Profile in use” under the RGB Source Profile or CMYK Simulation Profile.

New screenshot TBD

7 Click OK to exit Expert Color Settings.

8 Click OK to close the Properties window, and then click OK to send your job.
IMPORTING DENSITY MEASUREMENTS

This chapter describes Simple ASCII File Format (SAIFF), which you can use to import density measurements from measurement devices into ColorWise Pro Tools Calibrator. To use your own measurement data from an alternate measurement instrument, rather than make measurements directly in Calibrator, record your individual readings in a text file, structured as described in this chapter. You can then import the data into Calibrator by clicking From File under Get Measurements in the Calibrator main window.

Simple ASCII Import File Format

This format describes Status T measurement data for import into the ColorWise Pro Tools Calibrator. The three possible file formats are:

• 1D Status T density for EFI 21 patch page
• 1D Status T density for EFI 34 patch page
• 1D Status T density for other pages (maximum of 256 patches per ink)

The file format is ASCII and has no tabs. A single space or multiple spaces are used as delimiters. Blank lines are not allowed. Each line in the file represents four patches (C, M, Y, K) of a specific ink value. Comments may be on any line in the file. Comment lines must start with a pound sign (#) followed by a space. (A line with a pound sign followed by any character other than a space has been reserved.) Comments must be on a line by themselves.

Each line of data contains five values. The first number is the sequential patch number (for EFI 21 and EFI 34 pages) or the ink value percentage (for other pages). The four values that follow are the density values of C, M, Y, and K of the corresponding patch. Lines are ordered either by increasing sequential patch numbers, or by increasing the ink percentage.

For Windows computers, the file extension must be .cm1. For Mac OS computers, the file type must be ‘TEXT’.

Measurement data in EFI 21 and EFI 34 are paper-relative. For other pages, if the first line corresponds to zero ink value, the Calibrator assumes that the measurement data is absolute and adjusts it to become paper-relative by subtracting the density values of the first line from the remaining patches.
Example of 1D Status T density for EFI 21 patch page

This file format is used to specify the Status T density measurements of the EFI 21 patch page. The value in the first column is the patch number. The first patch must be 1 and the last must be 21.

```plaintext
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST21
# Cyan   Magent Yellow Black
1  0.0300  0.0400  0.0200  0.0400
2  0.0600  0.0700  0.0800  0.0700
3  0.1000  0.1000  0.1000  0.1000
(...more data...)
20 1.6700 1.3400 0.8900 1.6700
21 1.7200 1.4300 0.9300 1.7500
```

Example of 1D Status T density for EFI 34 patch page

This file format is used to specify the Status T density measurements of the EFI 34 patch page. The value in the first column is the patch number. The first patch must be 1 and the last must be 34.

```plaintext
#!EFI 3
# EFI ColorWise 2.0 Data
type: 1DST34
# Cyan   Magent Yellow Black
1  0.0300  0.0400  0.0200  0.0400
2  0.0600  0.0700  0.0800  0.0700
3  0.1000  0.1000  0.1000  0.1000
(...more data...)
33 1.6700 1.3400 0.8900 1.6700
34 1.7200 1.4300 0.9300 1.7500
```
Example of 1D Status T density for an arbitrary page

This file format is used to specify the Status T density measurements of a user-defined patch page. The value in the first column is the ink/toner percentage of the patch. The first percentage must be 0 and the last percentage must be 100. The percentages must increase in between.

#!/EFI 3
# EFI ColorWise 2.0 Data
type: 1DST
# percnt Cyan Magent Yellow Black
0.0000 0.0300 0.0400 0.0200 0.0400
0.3922 0.0600 0.0700 0.0800 0.0700
1.1765 0.1000 0.1000 0.1000 0.1000
(…more data…)
98.0000 1.6700 1.3400 0.8900 1.6700
100.0000 1.7200 1.4300 0.9300 1.7500
INDEX

A
Absolute Colorimetric rendering style 92
Apple Standard setting, RGB Source Profile option 93
Auto Trapping option 84
AutoGray 22

B
Black Detection option 84
Black Overprint option 85
Black Text/Graphics option 86

C
calibration
checking status 58
color 54
ColorCal 52
Comparison Page 36
curves 36, 57
DTP32 41
DTP41 43
ED-100 46
ES-1000 49
from Control Panel 52
importing density measurements 101
measurement page 57
measurements 56
overview 56
patches 57
restoring defaults 37
scheduling 58
targets 56, 57
viewing measurements 36
VisualCal 55
Calibration Files folder 12, 17
Calibrator
Expert mode 36
printing Comparison Page 36
restoring defaults 37
using 20, 34
viewing measurements 36
CMYK Color Reference.ps 12, 17
CMYK Simulation Method option 88
CMYK Simulation Profile option 87, 88
color calibration 58
Color Chart 54
Color Editor 20
AutoGray 22
color management system (CMS) 8
color profiles 10
color reference files
for Windows users 12
Color Reference pages 58
color rendering dictionary (CRD) 9, 92
Color Setup 30
color space 83
ColorCal calibration
from Control Panel 52
ColorWise
key features 8
print options 30
workflow diagram 83
ColorWise Pro Tools
Calibrator 20, 34
checking calibration status 58
Combine Separations option 89
Comparison Page 36
Composite Overprint option 90
composites, printing 86, 89, 95
Configuration page 13, 18, 58
connection, configuring 13, 15, 17, 19
Contrast ICC rendering style 92
Control Panel
calibration from 52
removing calibration 53
CRD 9, 92
custom simulations 87
Custom21.ps 12, 17
Custom34.ps 12, 17

D
densitometer
DTP32 41
ED-100 46
density 57, 58
importing 101
Device Link Profiles
  about 26
  assigning settings 28
  enabling using Color Setup 31
  enabling using Expert Color Settings 99
  installing 27
device name 14, 19
DNS name 13, 18
Domain Name Server 18
DTP32
  calibrating with 41
DTP41
  calibrating with 43

E
ED-100
  calibrating with 46
  importing measurements with 70
EFIRGB, RGB Source Profile option 93
ES-1000
  calibrating with 49
ES-1000, importing measurements with 70

F
Fiery utilities, configuring the connection for 15, 19
FieryColorBar.eps 12, 17
Full (Output GCR) setting, CMYK Simulation Method option 89
Full (Source GCR) setting, CMYK Simulation Method option 88

G
Graphics ICC rendering style 92
gray balance, correcting 22

I
ICC profiles 10
  defined 9
  downloading 26
  editing 20
  gray balance, correcting 22
  rendering styles 92
Image ICC rendering style 92

L
Lightness, Spot-On 68

M
Mac OS color management options 97
measurements page 57
monitor compensation
  Spot-On 69

N
None setting, RGB Source Profile option 94

O
output profile
  Spot-On 30, 59, 60, 69, 73, 74, 76
Output Profile option 91
output profiles 57

P
PANTONE Book.ps 12, 17
PANTONE Coated Color Reference 95
passwords, for calibration 34, 56
patches page 57
Perceptual ICC rendering style 92
Photographic rendering style 92
PostScript color issues 84, 85, 87, 94
PowerPoint, RGB color reference file 12, 17
PPD 96, 97
Presentation rendering style 92
Print Gray using Black Only option 91
print options
  Mac OS 97
  setting defaults 30
  Windows 96
printer drivers
  Mac OS 97
  two-way communication 88, 91, 94
  Windows 96
printer, recalibrating color output 54
printing, calibration pages 54
Profile Manager
  downloading profiles 26
  using 25
profiles 10

Q
Quick setting, CMYK Simulation Method option 88

R
Relative Colorimetric rendering style 92
rendering styles 9, 84
Rendering Styles option 92
RGB images
  defining source profiles for 93
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostScript and non-PostScript conversion</td>
<td>94</td>
</tr>
<tr>
<td>RGB page 01</td>
<td>12, 17</td>
</tr>
<tr>
<td>RGB page 02</td>
<td>12, 17</td>
</tr>
<tr>
<td>RGB Separation option</td>
<td>92</td>
</tr>
<tr>
<td>RGB Source Profile option</td>
<td>83, 93</td>
</tr>
<tr>
<td>SAIFF format</td>
<td>101</td>
</tr>
<tr>
<td>Saturation</td>
<td>68</td>
</tr>
<tr>
<td>Saturation ICC rendering style</td>
<td>92</td>
</tr>
<tr>
<td>separations</td>
<td></td>
</tr>
<tr>
<td>printing</td>
<td>86, 89, 95</td>
</tr>
<tr>
<td>target color space</td>
<td>92</td>
</tr>
<tr>
<td>simulations, custom</td>
<td>87</td>
</tr>
<tr>
<td>Source 1-10 setting, RGB Source Profile option</td>
<td>94</td>
</tr>
<tr>
<td>spectrophotometer</td>
<td></td>
</tr>
<tr>
<td>DTP41</td>
<td>43</td>
</tr>
<tr>
<td>Spot Color Dictionaries</td>
<td>30, 59</td>
</tr>
<tr>
<td>Spot Color Matching option</td>
<td>94</td>
</tr>
<tr>
<td>spot colors, CMYK equivalents</td>
<td>94</td>
</tr>
<tr>
<td>spot colors, matching to CMYK equivalents</td>
<td>30, 59</td>
</tr>
<tr>
<td>Spot-On</td>
<td>30, 59</td>
</tr>
<tr>
<td>adding color</td>
<td>63</td>
</tr>
<tr>
<td>Color Spacing</td>
<td>68</td>
</tr>
<tr>
<td>downloading color group</td>
<td>64</td>
</tr>
<tr>
<td>editing</td>
<td>65</td>
</tr>
<tr>
<td>Set Center Patch Color</td>
<td>66</td>
</tr>
<tr>
<td>Spot-On Color Search</td>
<td>68</td>
</tr>
<tr>
<td>Spot-On main window</td>
<td>65</td>
</tr>
<tr>
<td>ES-1000</td>
<td>70</td>
</tr>
<tr>
<td>factory defaults</td>
<td>71</td>
</tr>
<tr>
<td>Lightness</td>
<td>68</td>
</tr>
<tr>
<td>main window</td>
<td>61</td>
</tr>
<tr>
<td>monitor compensation</td>
<td>69</td>
</tr>
<tr>
<td>named colors</td>
<td>59</td>
</tr>
<tr>
<td>output profile</td>
<td>60, 73, 74</td>
</tr>
<tr>
<td>rearranging color group</td>
<td>62</td>
</tr>
<tr>
<td>renaming color</td>
<td>63</td>
</tr>
<tr>
<td>RGB or CMYK values</td>
<td>59</td>
</tr>
<tr>
<td>Saturation</td>
<td>68</td>
</tr>
<tr>
<td>Spot Color Matching</td>
<td>59</td>
</tr>
<tr>
<td>substitute colors</td>
<td>59</td>
</tr>
<tr>
<td>uploading color group</td>
<td>65</td>
</tr>
<tr>
<td>using measurement instruments</td>
<td>70</td>
</tr>
<tr>
<td>sRGB, RGB Source Profile option</td>
<td>93</td>
</tr>
<tr>
<td>Standard21.ps</td>
<td>12, 17</td>
</tr>
<tr>
<td>Standard34.ps</td>
<td>12, 17</td>
</tr>
<tr>
<td>Status T</td>
<td>101</td>
</tr>
<tr>
<td>Substitute Colors</td>
<td></td>
</tr>
<tr>
<td>accuracy</td>
<td>78</td>
</tr>
<tr>
<td>adding substitute colors</td>
<td>73, 77</td>
</tr>
<tr>
<td>CMYK (0-100%) mode</td>
<td>78</td>
</tr>
<tr>
<td>color substitution</td>
<td>79</td>
</tr>
<tr>
<td>defining</td>
<td>74</td>
</tr>
<tr>
<td>Set Center Patch Color</td>
<td>75</td>
</tr>
<tr>
<td>Spot-On Color Search</td>
<td>76</td>
</tr>
<tr>
<td>Spot-On main window</td>
<td>74</td>
</tr>
<tr>
<td>downloading substitute groups</td>
<td>81</td>
</tr>
<tr>
<td>new</td>
<td>72</td>
</tr>
<tr>
<td>new substitute group</td>
<td>73</td>
</tr>
<tr>
<td>principles</td>
<td>78</td>
</tr>
<tr>
<td>printing</td>
<td>76</td>
</tr>
<tr>
<td>priority scheme</td>
<td>80</td>
</tr>
<tr>
<td>renaming substitute colors</td>
<td>77</td>
</tr>
<tr>
<td>RGB (0-100%) mode</td>
<td>78</td>
</tr>
<tr>
<td>RGB (Device Code 0-255) mode</td>
<td>78</td>
</tr>
<tr>
<td>tolerance</td>
<td>78</td>
</tr>
<tr>
<td>tolerance range</td>
<td>78</td>
</tr>
<tr>
<td>uploading substitute groups</td>
<td>81</td>
</tr>
<tr>
<td>workflow</td>
<td>72</td>
</tr>
<tr>
<td>Substitute Colors option</td>
<td>95</td>
</tr>
<tr>
<td>SWOP</td>
<td>88</td>
</tr>
<tr>
<td>T</td>
<td></td>
</tr>
<tr>
<td>targets, for calibration</td>
<td>57</td>
</tr>
<tr>
<td>terminology</td>
<td>7, 33</td>
</tr>
<tr>
<td>Test Page</td>
<td>58</td>
</tr>
<tr>
<td>transfer functions</td>
<td>57</td>
</tr>
<tr>
<td>Two-Way Communication</td>
<td>88, 91, 94</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>undercolor removal (UCR)</td>
<td>94</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>VisualCal calibration method</td>
<td>54</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>Windows Color Files folder</td>
<td>12</td>
</tr>
<tr>
<td>Windows, print options</td>
<td>96</td>
</tr>
<tr>
<td>Word, RGB color reference file</td>
<td>12, 17</td>
</tr>
</tbody>
</table>